OPERATION MANUAL
(v. 2.1.1)
WARNING: TO PREVENT FIRE OR ELECTRIC SHOCK, DO NOT EXPOSE THIS APPLIANCE TO RAIN OR MOISTURE.

CAUTION: TO REDUCE THE RISK OF ELECTRIC SHOCK, DO NOT REMOVE COVER (OR BACK). NO USER-SERVICEABLE PARTS INSIDE. REFER SERVICING TO QUALIFIED SERVICE PERSONNEL. THIS PRODUCT IS INTENDED FOR USE INSIDE OF ELECTRICAL PANEL ONLY.

THE LIGHTNING FLASH WITH ARROWHEAD SYMBOL, WITHIN AN EQUILATERAL TRIANGLE, IS INTENDED TO ALERT THE USER TO THE PRESENCE OF UNINSULATED "DANGEROUS VOLTAGE" WITHIN THE PRODUCT'S ENCLOSURE THAT MAY BE OF SUFFICIENT MAGNITUDE TO CONSTITUTE A RISK OF ELECTRIC SHOCK TO PERSONS.

THE EXCLAMATION POINT WITHIN AN EQUILATERAL TRIANGLE IS INTENDED TO ALERT THE USER TO THE PRESENCE OF IMPORTANT OPERATING AND MAINTENANCE (SERVICING) INSTRUCTIONS IN THE LITERATURE ACCOMPANYING THE APPLIANCE.

WARNING: Use only modems supported by this monitoring unit. Dixell S.r.l. can accept no responsibility for possible damage due the usage of not supported modems.

WARNING: Dixell S.r.l. reserves itself the right to alter this manual without notice. The last version available can be downloaded from the website. Dixell Srl reserves the right to change the composition of its products, even without notice, ensuring the same and unchanged functionality.

WARNING: This manual describes XWEB300D/XWEB500D/XWEB500 functionalities. Special cases are clearly specified. Hereby instructions refer to firmware version 2.1 or previous.

WARNING: This controlling and monitoring unit is compliant with standard EN 12830 if it is used together with probes that are compliant with standard EN 13485

WARNING: This is a class A product. In a domestic environment this product may cause radio interference in which case the user may be required to take adequate measures.
INDEX

INTRODUCTION ............................................................................................................. 7
PACKAGING .................................................................................................................. 8
MINIMUM SYSTEM REQUIREMENTS FOR THE PC-CLIENT ......................................... 9
1 GENERAL INFORMATION .......................................................................................... 10
2 INSTALLATION .......................................................................................................... 11
   2.1 HARDWARE ......................................................................................................... 11
      2.1.1 RS485 .......................................................................................................... 12
      2.1.2 SERIAL ADDRESS ...................................................................................... 13
      2.1.3 THE TTL OUTPUT ....................................................................................... 13
      2.1.4 SERIAL ADDRESS OF THE INSTRUMENTS ............................................. 14
      2.1.5 TERMINATION RESISTOR .......................................................................... 14
      2.1.6 COMPATIBLE INSTRUMENTS .................................................................... 14
      2.1.6.1 PARTICULAR DEVICE SETUP ................................................................ 14
      2.1.7 REMOTE Connection FROM A CLIENT PC .............................................. 15
         2.1.7.1 MODEM Connection ("OR POINT TO POINT CONNECTION") .......... 15
         2.1.7.2 INTRANET / ETHERNET CONNECTION ............................................ 15
         2.1.7.3 INTERNET Connection ........................................................................ 16
   2.2 LOCAL LCD USER INTERFACE (COOLMATE MODELS ONLY) ........................... 17
      2.2.1 AVAILABLE MENU ..................................................................................... 17
         2.2.1.1 SETUP MENU ....................................................................................... 17
            2.2.1.1.1 DATE / TIME ............................................................................... 18
            2.2.1.1.2 DEVICE MENU ............................................................................. 18
            2.2.1.1.3 ALARM MENU .............................................................................. 19
            2.2.1.1.4 PRINTOUT ...................................................................................... 19
               2.2.1.1.4.1 AUTOMATIC PRINTING MENU ............................................ 19
               2.2.1.1.4.2 MANUAL PRINTING MENU .............................................. 20
            2.2.1.1.5 PASSWORD ................................................................................. 20
            2.2.1.2 VIEW MENU ...................................................................................... 21
               2.2.1.2.1 MODIFY SETPOINT .................................................................... 21
               2.2.1.2.2 DATA FROM ARCHIVE ............................................................. 22
            2.2.1.3 SYSTEM STATUS .............................................................................. 22
            2.2.1.4 GLOBAL COMANDS ...................................................................... 22
            2.2.1.5 ABOUT MENU ................................................................................. 22
   2.3 CONFIGURATION AND ACCESS ......................................................................... 23
      2.3.1 MICROSOFT WINDOWS: POP-UP BLOCKER AND COOKIES ...................... 23
      2.3.2 MICROSOFT WINDOWS: CACHE FILES .................................................... 25
      2.3.3 THIRD PART SOFTWARE AND XWEB ....................................................... 26
      2.3.4 SYSTEM CONFIGURATION ...................................................................... 27
      2.3.5 XWEB SETUP ........................................................................................... 28
      2.3.6 SYSTEM SETUP ........................................................................................ 29
      2.3.7 NETWORK SETUP .................................................................................... 30
      2.3.8 MODEM SETUP ....................................................................................... 31
      2.3.9 DIALUP SETUP ....................................................................................... 31
      2.3.10 E-MAIL SETUP ....................................................................................... 32
      2.3.11 SMS SETUP ............................................................................................ 33
      2.3.12 PRINTER SETUP ...................................................................................... 33
      2.3.13 XCENTER ................................................................................................. 33
      2.3.14 SYSTEM MESSAGES .............................................................................. 34
         2.3.14.1 MANUAL TEST: E-MAIL, FAX OR SMS SENDING ............................ 34
         2.3.14.2 SENDING AUTOMATIC REPORTS (ONLY FOR XWEB WITH SCHEDULER) .................................................................................................................. 34
3 USING XWEB ............................................................................................................ 35
   3.1 SYSTEM LOG-IN ............................................................................................... 35
   3.2 HOME PAGE ...................................................................................................... 35
      3.2.1 SYSTEM ACCESS ...................................................................................... 36
      3.2.2 IDENTIFICATION / TIME ......................................................................... 36
      3.2.3 SERVER PROPERTY ................................................................................... 36
3.2.4 ALARMS ........................................................................................................... 36
SHORTCUTS ............................................................................................................. 37
3.3 CONTROLLERS SETUP ...................................................................................... 37
  3.3.1 DEVICE FIND OF THE INSTRUMENTS CONNECTED TO THE “RS485” SERIAL LINE ............................................................................................................. 37
  3.3.2 CATEGORIES .................................................................................................. 38
    3.3.2.1 DEVICE TYPOLGY .................................................................................. 38
    3.3.2.2 RECORDING INTERVAL ......................................................................... 39
    3.3.2.3 RTC SYNCRONIZATION ......................................................................... 39
  3.3.3 SCHEDULER (ONLY FOR XWEB500DIN) ....................................................... 39
    3.3.3.1 PRINTING EVENTS .................................................................................. 45
    3.3.3.2 SYSTEM EVENTS ....................................................................................... 46
    3.3.3.3 USING THE SCHEDULER ........................................................................ 48
  3.3.4 ALARMS ........................................................................................................ 47
    3.3.4.1 ALARM TYPOLGY AND ALARM LEVELS ........................................... 47
    3.3.4.2 DESTINATION OF THE ALARM MESSAGES ....................................... 48
    3.3.4.3 ALARM LEVELS ....................................................................................... 49
    3.3.4.4 ALARM TYPOLGY MANAGEMENT ....................................................... 50
    3.3.4.5 QUEUED MESSAGES .............................................................................. 51
  3.3.5 CALENDAR FUNCTION .................................................................................... 51
  3.3.6 DEVICE CONFIGURATION ............................................................................ 55
    3.3.6.1 SELECT A DEVICE ................................................................................. 55
    3.3.6.2 ASSIGN THE NAME OF THE CONTROLLER .......................................... 56
    3.3.6.3 ASSIGN THE CATEGORY TO THE DEVICE “DEVICE CATEGORY SETUP” .................................................................................................................. 57
    3.3.6.4 ASSIGN THE ALARM TYPOLGY .......................................................... 57
    3.3.6.5 DEFINE THE DIGITAL, ANALOGUE INPUTS AND THE STATUS .......... 57
    3.3.6.6 CLONE FUNCTION ................................................................................... 58
3.4 STARTING MONITORING DATA ......................................................................... 59
3.5 DEVICES MENU .................................................................................................. 60
  3.5.1 SINGLE VIEW ................................................................................................ 60
  3.5.2 RUN TIME .................................................................................................... 61
  3.5.3 PARAMETERS ................................................................................................ 65
  3.5.4 LAYOUT FUNCTION (ONLY FOR XWEB500DIN) ............................................ 67
    3.5.4.1 LAYOUT EDITOR ....................................................................................... 67
    3.5.4.2 LAYOUT VIEW .......................................................................................... 75
  3.5.5 GLOBAL COMMANDS FUNCTION (ONLY FOR XWEB500DIN) ......................... 75
    3.5.5.1 GLOBAL EDIT ............................................................................................ 75
    3.5.5.1.1 DIGITAL INPUT SENDING COMMANDS ........................................... 77
  3.5.6 PERFORMANCE METER (ONLY FOR XWEB500DIN) ...................................... 79
    3.5.6.1 INTERPRETING THE %COOL .................................................................. 83
  3.6 CRO (ONLY FOR XWEB WITH CRO) .............................................................. 83
    3.6.1.1 GLOBAL COMMANDS ............................................................................ 85
3.7 DATA MENU ........................................................................................................ 85
  3.7.1 DISPLAY THE GRAPHS ................................................................................ 85
  3.7.2 EXPORTING DATA – SINGLE DEVICE ....................................................... 88
  3.7.3 EXPORTING DATA – MULTIPLE DEVICES ................................................ 89
  3.7.4 EXPORT TO USB PEN DRIVE ...................................................................... 91
  3.7.5 DELETE DATA ................................................................................................ 92
  3.7.6 DISPLAY THE GRAPHS WITH LOCAL PC .................................................. 92
3.8 ALARM MENU ..................................................................................................... 97
  3.8.1 HYSTORICAL ALARMS ................................................................................ 97
3.9 PERMISSIONS ...................................................................................................... 98
  3.9.1 MANAGING THE USERS ............................................................................ 99
3.10 TOOLS SECTION ................................................................................................ 99
  3.10.1 DATA LOG STATUS ..................................................................................... 99
  3.10.2 RS 485 TEST ................................................................................................ 99
  3.10.3 SERVER STATUS ........................................................................................ 100
  3.10.4 MESSAGE STATUS ...................................................................................... 100
3.11 INFORMATION MENU ......................................................................................... 101
  3.11.1 SYSTEM VERSION ....................................................................................... 101
  3.11.2 SYSTEM UPDATE ........................................................................................ 101

4 SAFETY AND ALLOWED USE ............................................................................... 102

4.1 SYSTEM SPECIFICATION ..................................................................................... 103
<table>
<thead>
<tr>
<th>Appendix</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>DEVICE ADVANCED SECTION</td>
<td>105</td>
</tr>
<tr>
<td>B</td>
<td>GLOSSARY</td>
<td>107</td>
</tr>
<tr>
<td>C</td>
<td>ACCESSORIES</td>
<td>109</td>
</tr>
<tr>
<td>D</td>
<td>GPRS CONNECTIVITY (ONLY FOR DIN)</td>
<td>109</td>
</tr>
</tbody>
</table>
INTRODUCTION

Congratulations! This manual will teach you everything about XWEB server, the most powerful and configurable tool for Controlling and Monitoring.

This manual is a comprehensive guide to your XWEB. You will find all the information you need to work with the unit.

The XWEB is based on the latest technology of the Internet world to display the WEB pages contained into the unit itself. The Linux operative system guarantees maximum efficiency and stability support for this kind of product.

All future software releases developed by Dixell will be available via internet connection. The Hardware inside the unit, based on high performance electronic boards, does not require any maintenance.
PACKAGING

Unpack the unit carefully and make sure that all accessories are put aside so they will not be lost. Examine the unit for any possibility of shipping damage. If your unit is damaged or fails to operate, notify your dealer immediately. If your unit was shipped to you directly, notify the shipping company without delay. Only the consignee (the person or company receiving the unit) can file a claim against the carrier for shipping damage. We recommend that you retain the original carton and packing materials for use should you transport or ship the unit in the future.

Inside the box you must find these articles:

- The XWEB server unit [1].
- One CD Rom containing the Operative manual and software [2].
- Power supply [3]
- Quick setup manual (Fast installation) [4].

If one of the above items is damaged, do not hesitate to contact your supplier.

MODEM (not included)

- When working with the modem connection always check the kind of modem you are going to install by verifying, with Dixell, the complete compatibility with the XWEB unit.
- Dixell is not responsible for bad functioning of unknown or untested devices.
MINIMUM SYSTEM REQUIREMENTS FOR THE PC-CLIENT

When connecting through local or remote connection, the client PC computer, must have installed these components:

Java Virtual Machine v1.6 or higher
Microsoft Internet Explorer 8. Usage of newer browsers, as Internet Explorer 9 or Mozilla Firefox or Google Chrome, is recommended implementing better some internet standards.

If necessary, inside the CDROM you will find the Java Virtual Machine program distributed by Sun® Microsystems.
Dixell S.r.l. is not responsible for any kind of damage occurring after the loading of the Java Virtual Machine program into the user’s PC.

Java is a trademark of Sun Microsystems, Inc.
1 GENERAL INFORMATION

XWEB is a Controlling and Monitoring system based on “WEB server” technology. In this document we can refer to XWEB as ‘server’. It is capable to communicate data to one external Client with the same kind of procedure used by the Internet Web Sites. Client need only a standard Browser such as Microsoft Explorer®.

The Web Pages with all the information are contained into the server itself; Linux operative system ensures maximum efficiency and security.

The server reads, logs and checks the data coming from the Dixell instruments connected to a RS485 line. The communication protocol is the Modbus-Rtu. The XWEB is capable of recognising also most of the Modbus-Rtu compatible instruments not manufactured by Dixell.

ATTENTION: Always check the proper RS485 connections (see 2.1.1 rs485)
ATTENTION: Dixell S.r.l. reserves itself the right to analyse the Modbus-RTU compatibility of other manufacturer’s devices before ensuring their integration into XWEB system.

Clients to Server connection possibility (PC—XWEB)

- **Modem**: point to point through local and remote modem devices (“Creating a Remote Access under Windows”);
- **Intranet / Internet**: where available a static IP, using the standard socket 10 Base-T with RJ45 connector.
- **Cross over Ethernet cable**: You can plug a bridge network cable into RJ45 socket of XWEB and on the other side into your PC network adapter. Ask your network administrator to properly setup your PC to be able to access XWEB web pages.

The User interface is defined by the Browser program and it is the same for all kind of connections. The PC-client needs only a standard Browser, there is no need to install any kind of software

Some pages created by the web server rely on Java and they need the Java Virtual Machine program that is normally installed in the latest Browsers and operative systems.

Features and functions included into the XWEB management:

- Data monitoring and recording, alarm detection and recording of the instrument connected.
- Alarm management defined by the User with visible signals (onboard led), or relay switching or remote transmission via Fax, E-mail or sms.
- Interactive commands to manage the connected instruments.
- Parameter table programming.
- Graphic or table viewing and printing of the recorded data.
2 INSTALLATION

2.1 HARDWARE

ATTENTION: to protect both yourself and the server from electrical hazards the XWEB should remain turned off until you are finished connecting all electrical devices to the unit.
To avoid accidental start of the unit, remember to plug in electrical cable only when you have finished setting up all other connection.

(ONLY FOR DIN MODELS)

<p>| | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>: alarm relay 1 (**)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>: alarm relay 2 (**)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>: System alarm relay</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>: 7-8 Alarm</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>: 7-9 Alarm present</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>: USB external peripherals</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>(**)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>(**)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>(**)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>: digital input (**)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

LED

<table>
<thead>
<tr>
<th>Led</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm</td>
<td>Red</td>
<td>RS485 Alarm</td>
</tr>
<tr>
<td>Rec</td>
<td>Orange</td>
<td>Data recording</td>
</tr>
<tr>
<td>Power</td>
<td>Green</td>
<td>System turned on</td>
</tr>
<tr>
<td>Status</td>
<td>Green</td>
<td>Messages are being sent</td>
</tr>
<tr>
<td>System</td>
<td>Red</td>
<td>System alarm</td>
</tr>
<tr>
<td>Alarm2</td>
<td>Red</td>
<td>Alarm Relay 2 status</td>
</tr>
<tr>
<td>Alarm1</td>
<td>Red</td>
<td>Alarm Relay 1 status</td>
</tr>
</tbody>
</table>

(*)= 12Vcc - 250mA. Modem supported TC-35 by Siemens
(**)= only for XWEB500DIN

WARNING: The status of led system is directly linked to the status of the relay “System alarm”.
2.1.1 RS485

To be connected to the serial line all the Dixell Modbus instruments must be provided with direct RS485 terminals or the “TTL”-RS485 interface (XJRS485 or XJ485). Check the instrument manuals for more information. The RS485 line is mainly based on two polarised terminals. Please beware to respect the right sequence for all the devices connected to the serial line.

Follow these important advises:
- The RS485 serial line must reach all the instruments where they are installed.
- Beware to the wire polarities when screwing them into the instrument terminals.
2.1.2 SERIAL ADDRESS

- The cable must have 2 or 3 wires with shield, minimum section 0.5mm² (e.g. the BELDEN 8772).
- From the XWEB position the cable reaches all the instrument positions.
- Do not execute loops or derivations:
  
  * Right connection

![Right connection diagram]

* Wrong connection

![Wrong connection diagram]

- Do not connect shield to ground.
- Do not connect the “Gnd” terminal.
- Remember to draw a map of the line. This will help you to find an error if something is wrong.
- The instrument with RS485 have “+” and “-” terminals, respect the polarity.
- To keep the line balanced it is necessary a 120 Ohm resistor at the end of the line (you can use the RS 485+ and RS 485- terminals of the last instrument connected).

2.1.3 THE TTL OUTPUT
• The instrument with RS485 on board do not need any kind of external interface module.
• For instruments with external interface: keep the TTL cable away from power cables or frequency sources.
• The XJ485 external interface must be connected with TTL cable to the instrument with TTL compatibility.

![XJ485 Diagram](image)

2.1.4 SERIAL ADDRESS OF THE INSTRUMENTS

• Each instrument must be defined by its unique address.
• Check the address into the Adr parameter value. Take reference to the instruction manual of the instrument itself to find the right procedure to enter the programming and set the value.
• The easiest way to work with the category functions is to set the addresses progressively for similar groups of instruments which have the same application.

2.1.5 TERMINATION RESISTOR

To keep balanced the RS485 the beginning and the end of line must be closed with a resistor of 120Ω. If XWEB is placed at the beginning or at the end of the line, please active its termination resistor by adding a jumper in position 2 (JMP2 on the back side of the unit). DO NOT add the jumper if XWEB is placed in the middle of the RS485 line.

2.1.6 COMPATIBLE INSTRUMENTS

For a complete list please read Appendix C.

2.1.6.1 PARTICULAR DEVICE SETUP

• All controllers equipped with 2 serial addresses (XC400/600/800/900, XH200/300/400 etc.) must be used with both addresses equal.
• iCHILLs need to activate a particular value in the “Advanced” section. User must check “Force Device On status”. Remember to stop-start acquisition after this operation.
• To use non Dixell, but Modbus compatible controllers (such as Energy Analyzer by Carlo Gavazzi) follow this instructions:
  a) Go to “Configuration” then “Devices”.
  b) On the drop down menu “Actions” select “New...”.
  c) A new pop-up window will appear: fill in the blank with the name of the controller and the ADR.
  d) Choose the proper device model (e.g. “ENERGY_8000000000000000”).
  e) Press “Create”
2.1.7 REMOTE CONNECTION FROM A CLIENT PC

2.1.7.1 MODEM CONNECTION (“OR POINT TO POINT CONNECTION”)

It represents the most common method where the LAN (intranet / Ethernet / internet) is not available. It is strongly advised to use a dedicated telephone line.

**IMPORTANT: Use exclusively modem devices approved by Dixell.**

Remember that many modems are not compatible with Linux. The list of compatible models can be found under the menu: Configuration – System – Modern. In appendix E, you can find the complete list of accessories together with their commercial name. Dixell can provide you these modems. You can decide to buy them in your country, but do not use different models from the ones stated here. Dixell is not responsible for any action depending on a modem that is not present in the official list of supported accessories.

**External Modem.**

Connect the modem to the COM Port on the back side using the modem cable commonly included into the modem packaging itself.

The reset of XWEB modem is directly controlled by the XWEB Server through the COM port, but if you use a GSM modem remember to use the external relay to cut the modem power supply to reset it.

Connect the modem to the telephone line with the phone cable included into the modem packaging.

Remember to check if there is a switching machine (add the prefix digit). The connection procedure is divided in two parts:

In the first part it is necessary to create the Remote Access, in your remote PC, set with the telephone number of the line where the XWEB is connected to. You have to use Dixell as Username and Password. The second is the procedure you will ever use: after launching the new Remote Access that will engage the line via the modem, start the Browser from your PC and insert the address `http://192.168.0.150` into Explorer/Netscape address bar. Proper information about setting up a dial-up connection for the client PC, can be found inside the INSTALLATION MANUAL on §4.3.

2.1.7.2 INTRANET / ETHERNET CONNECTION

The Intranet or Ethernet connection should be initially managed by the net administrator which will assign one free IP address to reach the Server. This number is an example of what you should expect: `http://192.168.000.111`.

After receiving the address from your network Administrator the XWEB must be set with this number. Use a standard RJ45 network cable to connect the unit to your existing LAN.

The Intranet method allows the connection to interact with XWEB from all the PC Clients. Insert the net address assigned by the administrator into the Browser address bar. Bookmark the address with personalised name for the future connections.
2.1.7.3 INTERNET CONNECTION

It is necessary a STATIC IP address for the XWEB which is normally assigned by the Provider of your internet services. The Internet connection allows XWEB to be reached from all PC-clients. Insert the net address assigned by the administrator into the Browser address bar. Bookmark the address with personalised name for the future connections.

Ask your provider for more details about the rent of a static IP. This the internet system requirements for the best result:

- Wide band connection.
- At least 1 static IP addresses for the XWEB.

The internet connection is established through a device called Router that receives and sends the data as interface between an Intranet and Internet. The Provider also assigns the address of the router that is called IP WAN.

Remember that the default value of the IP of the XWEB is: **192.168.0.150**.

Depending on the contract the Provider can also supply the router, otherwise the user can buy it separately. REMEMBER: ask qualified personnel for the router installation by using this information:

Used ports that are mapped to the LAN side:
- 22 (used for SSH connection)
- 80 (used for the Error! Hyperlink reference not valid. access)

The above ports are all related to the XWEB IP address 192.168.0.150. While the ports on the WAN side are:
- **http** (To access the XWEB)
2.2 LOCAL LCD USER INTERFACE (COOLMATE MODELS ONLY)

The local user interface consists of 8 keys:

<table>
<thead>
<tr>
<th>KEY</th>
<th>FUNCTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>VIEW</td>
<td>Direct access to the runtime data</td>
</tr>
<tr>
<td>MENU</td>
<td>Go to configuration menu</td>
</tr>
<tr>
<td>CLEAR</td>
<td>Exit current menu; delete a character</td>
</tr>
<tr>
<td>ENTER</td>
<td>Enter a menu, Enter current allarm list</td>
</tr>
<tr>
<td>&lt;-</td>
<td>left arrow</td>
</tr>
<tr>
<td>^</td>
<td>up arrow</td>
</tr>
<tr>
<td>v</td>
<td>down arrow</td>
</tr>
<tr>
<td>-&gt;</td>
<td>right arrow</td>
</tr>
</tbody>
</table>

When there is no alarm, the LCD is:

```
DIEXELLEXWEB500
SYSTEMOK
10:0115/03/2007
```

When there is an alarm the LCD is:

```
DIEXELLEXWEB500
035NOLINK
10:0115/03/2007
```

The third row displays the address of the controller and the type of the alarm. To stop the buzzer press ENTER, automatically the current alarm list will be displayed. To be able to reset an alarm the user must have received the permission by the administrator.

2.2.1 AVAILABLE MENU

By pressing the MENU key:

```
-> Setup
  View
  System status
  Global command
  About
```

2.2.1.1 SETUP MENU

Press ENTER when you are in setup:

```
-> XWEB 500 unit
  Date / time
  Device(s)
  Alarm
  Printout
  Password
```
XWEB 500 unit let you setup:

- Language Identification
- Delete archive
- Network
- Modem
- Dial up
- e-mail
- SMS
- FAX
- Printer

- Delete archive completely empties the recorded temperatures and alarms. It empties the corresponding database.
- Network is for the setup of the network. The system must be rebooted to apply a new setup.
- Modem is for the modem setup.
- Dial up is to setup the dial-up connection.
- e-mail is for the e-mail setup. The option “Testing e-mail” let you send a test e-mail.
- Printer is to setup the USB printer. The setup via web-browser is strongly suggested for this entry.

2.2.1.1 DATE / TIME
To setup, date, time and timezone

2.2.1.2 DEVICE MENU

- Add
- Delete
- Setup
- Recording interval

To add a new device the system must be in STOP mode (i.e. RS485 reading must be turned off).
- Add is to add a new device. Only 100 devices can be added [the maximum number of devices may vary depending on the considered model]
- Delete is to remove a device.
- Setup is to configure a device according to the following parameter:
  - Address: ADR parameter
  - Name: name of the controller
  - Interval: recording interval
  - Read: enable data reading for the selected controller
  - Record: enable data recording for the selected controller
  - RTC: enable real time clock synchronization
  - Print: enable the printout for the selected controller
- Recording interval is to setup the interval between two samples of data. Only 1 category can be setup in the LCD. Other categories can be added by means of the WEB user-interface.
2.2.1.1.3 ALARM MENU
Alarm management by means of the LCD can setup only 1 user. To add new user please use the WEB user-interface.

- Delay
  - Accumulation
  - Send FAX: Sì/No
  - Send e-mail: Sì/No
  - Send SMS: Sì/No
  - Receiver(s)
  - Relay

  - Delay is to filter the alarms. If an alarm lasts less than the delay, XWEB 500 only records it in the alarm log. If it lasts more than the delay, XWEB 500 will send it according to the accumulation time.
  - Accumulation time let you group together different alarms that belongs to the same level. Only one alarm message will be sent: inside this main message all the others will be added.
  - Send FAX enables fax sending
  - Send e-mail enables e-mail sending
  - Send SMS enables SMS sending
  - Receivers let you setup the default receiver’s information:
    - Default name can be modified by pressing ENTER
    - FAX 1: first fax number
    - FAX 2: back-up fax number
    - E-mail: e-mail address
    - SMS: mobile phone number

  - Relay let you setup the ALARM1 and ALARM2 relays:
    - ALARM1: enable/disabled
    - ALARM2: enable/disabled
    - BUZZER: enable/disabled the buzzer

2.2.1.1.4 PRINTOUT
Two different type of printouts are available.

- Automatic printing
  - Manual printing

2.2.1.1.4.1 Automatic printing MENU

- time
  - Print Data. Yes/No
  - Print alarms. Yes/No

  - Time is to setup the time of the day a printout is automatically printed by the XWEB500
  - Print Data is to print the recorded temperatures
  - Print Alarms is to print the list of the alarm
2.2.1.4.2 Manual printing MENU

- Alarm
- Data
- XWEB500 Setup
- Device(s) Setup

- Alarm is to choose between the current alarm list and the recorded alarm list
- Data is to choose the recorded temperature in the archive
- XWEB500 setup prints the setup of the XWEB500 (network, receivers, users, etc…)
- Device(s) Setup prints the setup of the controllers

2.2.1.5 PASSWORD

The management of the user by means of the local LCD is different from the one by means of the WEB user interface. Security management is turned off by default.

- Users' permissions: Yes/No

When users’ permission is ON, a password for each user must be set:

- Users' permissions: Yes/No
  - Administrator
  - User 1
  - User 2
  - User 3
  - User 4

Please select the Administrator and assign it a password. Automatically it appears “Password:*”. Press ENTER to modify it.

Please select user 1 and assign it a password. It is possible to modify the following options:

- Send command
  - Global command
  - Modify setpoint
  - Modify unit
  - Modify time
  - Modify devices
  - Modify alarm
  - Alarm reset

- Send command is to send a command to the controller
- Global command is to send a global command (if available)
- Modify setpoint let you modify the setpoint of a controller
- Reset alarm to reset an alarm (buzzer and relays)

When the user insert the password the system grant him complete acces only for 1 minute. After this timeout the user must insert the password again.
2.2.1.2  VIEW MENU
By pressing VIEW the following options are available:

- Data
- Alarm
- Tools

- Data is to browse the current/recorded temperatures
- Alarm is to browse the current/recorded alarms
- Tools let you start the RS485 line test

2.2.1.2.1  MODIFY SETPOINT
By using Data menu, then actual, it is possible to modify the setpoint of a controller. This is the view layout:

-> Name of the controller
   >---A-INPUT--------<
   Air Temperature: 4.20°C
   >---SETPOINT--------<
   Set point: 4°C
   >---D-INPUT--------<
   Open door: OFF
   Generic alarm: OFF
   >---STATUS--------<
   ON/OFF: ON
   Defrost: OFF
   >---OUTPUT--------<
   Defrost: OFF
   Fan: OFF
   Compressor: ON
   >---ALARM--------<
   High Temperature: OFF
   Low Temperature: OFF
   Generic alarm: ON
   >---COMMANDS--------<
   OFF
   ON
   DEFROST

>---A-INPUT--------< means analog inputs (probes)
>---SETPOINT--------< setpoint
>---D-INPUT--------< means digital input
>---STATUS--------< reports the status of the controller
>---OUTPUT--------< reports the outputs status of the controller
>---ALARM--------< current alarm list
>---COMMAND--------< current command list

To modify the setpoint move the marker “->” to highlight the actual setpoint and modify it by pressing ENTER. Increse/decrease the current value by means of the up/down arrow keys. Press ENTER to confirm.
To send a command, scroll the list until you reach the section >---COMMANDS--------<, select the command and press ENTER. To confirm press ENTER again.
2.2.1.2 DATA FROM ARCHIVE

View
From: 10:30  10/01/2007
Interval: 01:00

The archive can be browsed between the “From” date and the today day. (in the above example the archive will show data from 10:30 a.m. January 10th 2007 until today). Interval is the distance between to samples of data (i.e. time difference between to 2 recorded temperatures). Move the marker “->” above “view” and press ENTER. To move to the next recorded temperatures, press VIEW.

2.2.1.3 SYSTEM STATUS

Data reading: Yes/No
Data recording: Yes/No
Alarm sending: Yes/No

➢ Data reading starts the monitoring unit
➢ Data recording starts the recording of the temperatures.
➢ Alarm sending starts the alarm sending procedure

2.2.1.4 GLOBAL COMANDS

This function can be activated only by means of the WEB user interface. Once a command is available, it will be showed in this list.

2.2.1.5 ABOUT MENU

This menu shows the release of the XWEB500, moreover it shows the unique MAC address of the unit.
2.3 CONFIGURATION AND ACCESS

Before turning on the XWEB read these notes.

The local access via network cable is the fastest way to manage the first setup of the unit. Be sure the PC-client is provided with Java Virtual Machine. Launch the Browser and insert the default address 192.168.0.150.

2.3.1 MICROSOFT WINDOWS: POP-UP BLOCKER AND COOKIES

XWEB uses some pop-up windows to show the user the real status of each operation, unfortunately these pop-ups are blocked by Windows pop-up blocker. Usually Internet Explorer adds a yellow bar to inform you about the blocked pop-up (image below).

To avoid this problem, please follow these rules:

1. Go to “Tools” and then “Internet Options...”: 

   ![Internet Options](image)
2. From the TAB “Privacy”, apply the “Default” settings and press the button “Settings...” on the bottom right corner.
3. Add the default address of XWEB, i.e: 192.168.0.150.

Please remember to add each IP address you will use to this list.

2.3.2 MICROSOFT WINDOWS: CACHE FILES

Often referred to as the cache, the Temporary Internet Files folder contains a kind of travel record of the items you have seen, or downloaded from the Web, including images, sounds, Web pages, even cookies. Typically these items are stored in the Temporary Internet Files folder.

Storing these files in your cache can make browsing the Web faster because it usually takes your computer less time to display a Web page when it can call up some of the page's elements or even the entire page from your local Temporary Internet Files folder, but at the same time can prevent you from receiving correct information from the XWEB you are connect to.

These files also take up space, so we suggest deleting them periodically. When you clear out the files stored in your cache you go through the “clearing the cache” procedure.

To clear your cache:
1. On the Internet Explorer Tools menu, click Internet Options. The Internet Options box should open to the General tab.
2. On the General tab, in the Temporary Internet Files section, click the Delete Files button. This will delete all the files that are currently stored in your cache.
2.3.3 THIRD PART SOFTWARE AND XWEB

As general rule please remember that software such as antivirus programs, firewall programs, toolbars (Yahoo and Google bar) may prevent you from connecting properly to XWEB. We strongly suggest to check these softwares setup and add the IP address of XWEB to the trusted site list of your software. As far as firewall is concerned, add port 80 and port 22 to the allowed ports forwarding, of course all the TCP/IP requests coming from the IP address of XWEB must be allowed.
2.3.4 SYSTEM CONFIGURATION

As soon as the power supply cable is plugged in, the system starts loading. The on-board display shows you the bootstrap procedure with a slide-bar.

After the first loading of the operative system, the user is required to setup the XWEB.

The first window asks you to log-in to the system. Use Admin as “User name” and “Password”.

![Image of login screen]
2.3.5 XWEB SETUP

Click on “Configuration” -> “System” roll-down menu. This window will appear:
2.3.6 SYSTEM SETUP

Click on “System setup” to adjust System name, description, language, date/time and time-zone format. They are important because the system will use its time stamp to record and send alarm.
2.3.7 NETWORK SETUP

By clicking “Network Setup” is possible to customize all network settings. The default IP is 192.168.0.150, if you change it, please refer to this new number each time you encounter the default IP inside this manual.

The next window allows you to setup the network. You can choose “No network”, it means you will not be able to reach your XWEB using intranet/lan access. This is an uncommon situation. On the other side if you check the radio button “fixed network”, you have to fill in the blank labels. We suggest you, before proceeding, to contact your network administrator to get help.

**IP ADDRESS:** you need this unique number to identify your XWEB. There are 2 kind of IP numbers: private and public ones. The first are usually used to setup an intranet/lan where all clients do not need to be reached from outside. We can compare this situation to a close environment: communication is possible only among IP belonging to this private range. For example IP numbers 192.168.xxx.yyy defines a private network.

**NETWORK MASK:** is just like a filter, 255.255.255.0 means XWEB can directly reaches only PCs belonging to its own IP range. All other requests will be sent to a valid gateway.

**GATEWAY ADDRESS:** You have to compile this field with a valid gateway IP number. Gateway machines are a kind of portal through which all data that can not directly reach the target IP, is sent.

**PRIMARY/SECONDARY DNS:** In the internet world you can reach a web server using its name, for example www.dixell.com, by typing the name into your web-browser address bar. Due to the protocol used to guarantee performance and security, all names are converted into IP numbers. This operation is made by a DNS server. Usually your ISP or your network administrator can provide you a valid DNS number. DNS are also mandatory to use e-mail and the internet upgrade procedure.

**Webserver port number:** use it to set a different port number for the web server. In the example the new address to go to XWEB500 is http://192.168.0.150:8080

**DHCP Server:** use it to force Ethernet network configurations from XWEB. This parameter is usually disabled and please enable this function only after consultancy by network administrator.
### 2.3.8 MODEM SETUP

Next window allows you to setup the modem connection. XWEB uses the modem to send faxes and in some cases also e-mails. In the first case the unit itself can send a fax, while in the second case you may need to setup a dial-up connection (next step).

When XWEB modem is in use, it is important to choose the country according to the real country where XWEB is installed. From the drop down menu “country”, choose yours (either internal or external one, but also both of them). Please choose your country to avoid modem malfunctioning. If your country is not available in the supported list, please contact Dixell. XWEB can manage up to 2 modem simultaneously: enable/disable them according to your real application. Remember also to set “Dial-in calls” and the number of rings before the answer of the modem.

To use a XWEB model with integrated modem (GPRS), select ‘internalGSM’ in the “internal modem” section and enable the calls from internal modem in the “incoming calls” section. This function is available only for DIN models.

<table>
<thead>
<tr>
<th>Internal modem</th>
<th>Use internal modem:</th>
<th>Model:</th>
<th>internalGSM</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Country:</td>
<td>Italy</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Modify</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>External modem</th>
<th>Use external modem:</th>
<th>Model:</th>
<th>XWEB Modem</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Country:</td>
<td>Italy</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SMS:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Modify</td>
<td></td>
</tr>
</tbody>
</table>

**Dial-up calls**

<table>
<thead>
<tr>
<th>Enable calls from:</th>
<th>Number of rings before answering:</th>
</tr>
</thead>
<tbody>
<tr>
<td>internal modem</td>
<td>1</td>
</tr>
<tr>
<td>External modem</td>
<td></td>
</tr>
<tr>
<td>Modify</td>
<td></td>
</tr>
</tbody>
</table>

### 2.3.9 DIALUP SETUP

Click on “Dial up” to proper setup the internet connection for sending e-mails. You need a valid internet account, then fill in all the field.

If you do not have a valid SMTP Server, once connected to the Internet, XWEB will try to send the e-mail directly to the receiver. This type of operation is NOT support by all ISP (internet service provider). For this reason it is strongly recommended to use a valid SMTP.

When using a GPRS modem integrated in XWEB, the dial-up line does not work. Instead, configure the “GPRS configuration” that follows in the same page.

For a complete configuration example for a GPRS configuration see appendix D.
2.3.10 E-MAIL SETUP

XWEB can handle e-mail, but to send them you need to make a proper setup of the unit. XWEB can send e-mail either via network or via dial-up, please choose the proper option according to your needs. To send e-mails a SMTP server must exist and XWEB have to reach this server through the LAN or via dial-up. In this case gateway and DNS parameters are mandatory in “Network Configuration” window. If dial-up is used therefore there is no direct LAN access to internet. In this case a modem is needed, XWEB will contact directly your ISP provider and using its services will send all the e-mails. To send e-mail you need a valid SMTP server. Usually your LAN administrator will provide you a server name, for example dixell.com (another format widely used is mail.company-name.com), then a valid e-mail address is needed.

We strongly suggest you to create a new e-mail account to use with XWEB. In this case, e-mail header will be something like this: xweb@your-company-name.com. This is very useful to apply e-mail filtering in the client PC. It is not necessary to have a dedicated mail account to use e-mail services, but is strongly recommended because for example many SMTP servers need user account authentication (especially ISP) and in this case without a proper user you can not send e-mails. Moreover if your SMTP requires authentication, please check “Yes” box and fill in with the right values. If either network or dial-up setup has already been done, you can send a test e-mail/SMS/Fax by pressing the proper button.
2.3.11 SMS SETUP

XWEB can send SMSs using several kinds of services to notify user about detected alarms on Devices Network.

To use Netech service (SMS via internet) please read http://www.netech.it/ir_smsalert before proceeding. After the online registration module has been submitted you will receive via email the activation code. Use it to configure your XWEB. This service provides statistics and to clearly recognize it we recommend to configure your XWEB with a name that makes it unique. Proceed purchasing SMSs from Netech web page.

To use GSM service (using credit you may have in your SIM card) enable internal/external modem enabling GSM parameter.

To use SOpen Corea service (SMS via internet. For Corea only), setup ‘network’ and ‘SOpen’ and configure XWEB with Activation Code, sMsgCd and sSendNo codes you have received from your Corean provider with an unique XWEB name.

To use RavenXE service (using credit you may have in your SIM card but using an external RavenXE modem), setup ‘network’ and ‘raven XE’ then configure its IP address and its port. Refer to its manual for instructions.

2.3.12 PRINTER SETUP

This unit supports only USB printers. To obtain a list of tested printers you should connect to www.dixell.com on XWEB support section or you can click on http://www.dixell.com/linea58/download/printers_XWEB.pdf

To enable the printer, you have to select your printer from the list and you should select the right driver (or that one Dixell can advise you):

2.3.13 XCENTER

The centralized alarm management software, automatically enables XWEB500 to be part of the monitored network. The user later can disable the alarm sending to the XCenter (warning: delay and accumulation time will be considered as usual).
2.3.14 SYSTEM MESSAGES

XWEB is able to send a complete report of the past activity. The report can be sent both automatically and manually according to an event calendar defined by the user (see Scheduler §). Moreover if the system is working out of the standard operative range (i.e. cpu temperature), automatically a report will be sent out. This tool can also be used when the user wants to test the system setup, in fact it is possible to test for example the e-mail: XWEB will send an e-mail to the selected receiver.

Enable system notification: enable/disable reporting activity
Enable alarm relay: enable/disable alarm relay when an alarm occurs (high temperature, a faulty RS485 hardware and blackout)

2.3.14.1 MANUAL TEST: E-MAIL, FAX OR SMS SENDING

Select the user in the “Receiver” drop down menu, then select the message type you want to receive. The calendar option let you choose whether to filter the messages according to the calendar (ref. 3.3.5) or not. By pressing “Send message” the system tries to send the message.

2.3.14.2 SENDING AUTOMATIC REPORTS (ONLY FOR XWEB WITH SCHEDULER)

To receive an automatic report you must tick “Enable system notification” (in the above window), then go to “Configuration” then “Scheduler”. Choose “Event” and finally “Add system event”. The following window will appear:

In the above example the system will send a report everyday at 09:00 a.m.
For an in deep explanation on Scheduler, please see §3.3.3 Scheduler
3 USING XWEB

3.1 SYSTEM LOG-IN

Once the connection is activated, insert the IP number into the address bar of your browser. The first window shows the Login with User Name and Password fields.

If the name and the password are correct the Home Page is loaded otherwise you must repeat the operation: check your password (numbers, capital letters etc.). Remember that default Administrator can log to the unit using:

- **User name:** Admin
- **Password:** Admin

Please consider to change the default password to increase system security (everybody can read this manual and steals the admin account).

**ATTENTION:** After the first installation is complete, the XWEB user database is made of 1 administrator and 2 users. Please go to Configuration -> Users roll-down section to ensure proper security rights to each users.

3.2 HOME PAGE

When the Home Page appears the connection is effectively working. Depending on the used password the User can operate on the server with or without limits decided by the Administrator of the XWEB.
3.2.1 SYSTEM ACCESS

- The user defined as “Administrator” is the only one allowed to modify everything inside the Server. The other users operate with their permission rights (see “§3.9 permissions”).

3.2.2 IDENTIFICATION / TIME

- Name
- Description

These items represent the name of server and its description.

3.2.3 SERVER PROPERTY

<table>
<thead>
<tr>
<th>Server</th>
<th>Active</th>
<th>Start/stop</th>
<th>Status</th>
<th>Sync time/date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Reading</td>
<td>Active</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Data Recording</td>
<td>Active</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alarm Sending</td>
<td>Active</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Server Status</td>
<td>OK</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Time:</td>
<td>15:38:30</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Data Reading: Reading activity on RS 485 controllers.
- Data Recording: Recording activity on RS 485 controllers.
- Alarm Sending: Alarm transmission status
- Server Status: OK, or a warning icon will be displayed
- Time: System Clock

3.2.4 ALARMS

This area immediately on the right hand side shows the currently active alarms of the instrument.

The alarm list is repetitively updated in a short time interval.
To manually force the alarm updating: click on the “Refresh” button

<table>
<thead>
<tr>
<th>Adr</th>
<th>Device</th>
<th>Alarm</th>
<th>Start</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>new-XR170C</td>
<td>Open Door</td>
<td>06/04/2006 17:41:53</td>
</tr>
<tr>
<td>5</td>
<td>new-XR170C</td>
<td>Open Door</td>
<td>06/04/2006 17:41:53</td>
</tr>
<tr>
<td>4</td>
<td>new-XR70CK</td>
<td>Error Pb1</td>
<td>06/04/2006 17:41:52</td>
</tr>
<tr>
<td>2</td>
<td>new-XR570C</td>
<td>Open Door</td>
<td>06/04/2006 17:41:51</td>
</tr>
</tbody>
</table>
SHORTCUTS
This section shows a list of shortcut icons to quickly access to most used XWEB functionalities.

3.3 CONTROLLERS SETUP
In this section you can read instructions on how to configure your XWEB with Devices connected to its RS485 network.

3.3.1 DEVICE FIND OF THE INSTRUMENTS CONNECTED TO THE “RS485” SERIAL LINE
The unit is capable to find the Dixell instruments connected to the RS485 serial line. Before starting the procedure be sure that all the devices are properly connected to the RS485 line and the corresponding addresses are properly set. Be sure that all the instruments are properly supplied. Be sure of the number of the instruments you are going to find to avoid losing time in counting them later. To start the procedure, first click on “Data recording” and uncheck all values, push modify. Click on “Configuration -> “Device find” roll-down menu. A new page loads.
Adjust the address range and push “Start”. During the RS485 polling Tx/Rx led blinks and this window will appear:

When the search is complete a new window will appear. To use the new controllers, under “Operation” column check the box “Insert”, then push “Add”.

### 3.3.2 CATEGORIES

This function allows you to define the functioning attributes and the working features of the instruments themselves. The user is required to preventively decide the list of these features. Lately, when working with the Device configuration, each device can be easily configured with these appropriate attributes. Some categories can be defined also with “Default”. In this case the category is initially proposed as default during the instrument configuration.

Click on “Configuration” “Category” roll-down menu.

#### 3.3.2.1 DEVICE TIPOLOGY

This category defines the application at which the instruments belong to. E.g: “Display cabinets” “Frozen food”, “Meat Room”, “Air Conditioning”, etc.

- **To insert a new item**
  Click “New” and then into the field “Name”. Insert the word or the words that more represents the application;

  The most common category should be set as “Default” by clicking into its box;
  Only one “Default” can be selected for each category;
  Click “Insert” to include the new item into the list. Wait the screen refresh.

- **To modify an existing item**
  Click on the name-field and modify it, then press “Modify”;
  Click the “Set as Default ” if necessary;

- **To delete one of the item of the list**
  Click on “Cancel”;
  Confirm the operation if necessary. Wait the screen refresh.
3.3.2.2 RECORDING INTERVAL

Define the recording intervals of the instruments to log the data into the archive.
Eg: “Standard = 15min.”, “Fast = 3min.”.
XWEB can define different log intervals for different instruments when the log frequency is not the same for all the instruments.

- **To insert a new item**
  - Click “New” and then into the field “Name”. Insert the word or the words that more represents the application;
- **To modify an existing item**
  - Click on the name-field and modify it, then press “Modify”;
  - Click the “Set as Default ” if necessary;
- **To delete one of the item of the list**
  - Click on “Cancel”;
  - Confirm the operation if necessary. Wait the screen refresh.

3.3.2.3 RTC SYNCRONIZATION

In this section user can decide how often to synchronise the controller equipped with a real time clock.
Interval is expressed in hh:mm. The maximum value accepted is 12:00. It means that every 12 hours a synchronise-command is sent to the controller. To enable a controller, the user has to go to the “Devices” page and check the “RTC Sync” checkbox.

3.3.3 SCHEDULER (ONLY FOR XWEB500DIN)

This is a powerful tool for managing category and repetitive commands. Now it is possible to send command to a set of controllers and have a “visual” chart. This feature, for instance, is very useful to avoid command time-overlap.
To start the “Scheduler”, use the drop-down menu “Configuration”, then “Scheduler”. This window will appear (Java is required):

On the bottom there is a timeline (00:00 to 24:00), each hour is marked with a vertical line. This main window is very useful to build a complete time table in a very easy and fast way.
File Submenu:

- **SAVE**
  This function allows you to save the changes done till now. Beware that the system cannot go back to a previous save, only the last one is available.
- **PRINT**
  Execute the operation of printing your configuration using your PC.
- **EXPORT TO FILE**
  Execute the operation of saving the configuration on the hard drive of your PC.
- **SCHEDULER ENABLED**
  Enabling the tick, the scheduler is enabled on every condition.
- **SCHEDULER ENABLED ON OPENED DIGITAL INPUT**
  Enabling the tick, the scheduler is enabled on open digital input status.
- **SCHEDULER ENABLED ON CLOSED DIGITAL INPUT**
  Enabling the tick, the scheduler is enabled on closed digital input status.
- **EXIT**
  Closes the Scheduler.

Class Submenu:

- **CREATE CLASS**
  By using this menu it is possible to create a new class.

  Fill in “Class Name” field, then pick up a Category. Wait for the complete list of the controller. Check all the controllers you want to send a command and push “Add Command event”. If you want to manage a time-scheduled printout, please choose “Add printing Event”.
Choose a command, then fill in “Activation Time”. Choose a marker and its colour. Push “Confirm” to add this event to the Scheduler.

After having selected “Add Printing Event”, use the drop-down menu “Fast Selection”, or if you prefer you can also select all the analog values manually.

Insert the time schedule “Activation Time” and the “Marker Colour”. Press “Confirm”
The various controls on the form allow the functioning described below:

- Fast Selection listbox: allows an automatic selection of first value of each device on selected class in order to obtain as fast as possible an HACCP printout (for example);
- Activation Time field allows to decide when the printing or the FAX or email sending activities will be performed;
- The Printout Name field has to be used to a “title” for your printout or in general for your event;
- Realtime printout is a printout of all the values that are sampled at Activation Time;
- Archive: allows to print or send an email with the data that are stored on XWEB memory starting from Activation time and coming back of back interval quantity of time (up to 48 hours) with Interval (sampling time). The Interval sampling time can be used only if the Extended check box is selected, otherwise the sampling time is automatically evaluated dividing the back interval in 6 samples. Switching the printout between Extende or not, the layout of the printout will change accordingly to the layout that can be fill the page better;
- Headers: in order to give the possibility to customize the printout, it’s possible to use the Headers section. In this way, a user defined text can be added at the top and at the bottom of the printout;
- Print copies field allows to print more than one copy at time;
- FAX/EMAIL group box allows to send an EMAIL or a FAX depending on the receivers that have been configured on alarm section. In case of sending an email, there is also the possibility to receive data as attachment with CSV (comma separated value) or Text format;

**EDIT CLASS**
Use this menu to modify an existing class.
choose the class you want to modify then press “Edit”. If you want to delete a class, choose it and press “Delete”.

Event submenu:

- **ADD EVENT**
To add an event to an existing class.

![Event Definition](image)

Choose a class then select a command. Fill in “Activation Time”. Choose a marker and its colour. Push “Confirm” to add this event to the Scheduler.

- **ADD PRINTING EVENT**
The system loads the same menu already discussed at previous point (regarding the HACCP printout).

Edit days submenu:

- **NEW DAY DEFINITION…**
Use this menu to create a new day definition.

![Day Definition](image)

Choose a Name and a colour. Mark “Yearly” option if you want this day definition applied to all available years.
When you define a new day, please note that the system automatically uses the command chart present in that moment in your PC screen. This means that the first time you start working with the scheduler the default day is displayed.

Point a day, then with left mouse button click on it. A menu with all the available day definitions will appear.

- **DELETE DAY**
  Delete the current day.

**Windows submenu:**

- **SHOW LEGEND**
  This menu shows all the command marker used.

- **SHOW CALENDAR**
  This menu shows the current calendar association

- **SHOW LOGS**
  This menu shows a brief log concerning the command schedule.
It is possible to filter all the command sent using “From”, “To” and Class.

- **SHOW COMMANDS**
  This menu filters only the commands.

- **SHOW PRINTINGS**
  This menu filters only the printing events.

**Days submenu:**

- **DAYS**
  It allows to switch between different days definition.

### 3.3.3.1 PRINTING EVENTS

If you want to manage a time-scheduled printout, please choose “Add HACCP Event”.

Choose a command, then fill in “Activation Time”. Choose a marker and its colour. Push “Confirm” to add this event to the Scheduler.

After having selected “Add Printing Event”, use the drop-down menu “Fast Selection”, or if you prefer you can also select all the analog values manually.

Insert the time schedule “Activation Time” and the “Marker Colour”. It is possible to have both a standard printout, a fax and an e-mail.
3.3.3.2 SYSTEM EVENTS
There is a class that cannot be removed: XWEB System Events. The user can add to this class only system events to receive scheduled report from the unit. To add a new event go to “Add event” then “Add system event”.

The following window will appear:

Fill in “Activation Time” and choose a mark colour. Press confirm.

3.3.3.3 USING THE SCHEDULER
Once you have created a schedule it is possible to check or modify an existing event in a very simple way. Use left mouse button and click on it. If there is a marker overlapping (this means that 2 or more events start at the same time), the applet will show you a brief list of all the event available. With left mouse button you can select the one you want to modify or delete.
3.3.4 ALARMS

3.3.4.1 ALARM TYPOLOGY AND ALARM LEVELS

The alarm typology is a list of alarm events designed by the user to describe the possible alarms that the instruments can generate.

In this way similar alarm events can be grouped together under a unique identification label, so high and low temperature alarms can be defined as "Temperature alarms" or the high and low pressure alarms belong to "Pressure alarm" identification.

The Alarm Level list is also designed and named by the user. Each alarm level can be assigned with one or many alarm typologies.

The alarm level starts the appropriate action in case of alarm event and depending on the level of alert it transfers the information via fax or e-mail with appropriate messages or turn on relays etc.
3.3.4.2 DESTINATION OF THE ALARM MESSAGES

The list of the destinations contains the users (directors, maintenance personnel, assistance etc.) enabled to receive the alarm notification.

The XWEB is capable of transferring the alarm message through Fax, SMS or e-mail.

- **To insert a new item**
  Click into the field “Name” and insert the appropriate word or words.
  Click on “Insert” to add the new value.

- **To change the setting**
  Click into Selection and find the desired item from the list.
  Click into the desired fields and change them with the appropriate values.
  Click on “Modify”.

- **To delete an item**
Select the user to delete.
Click on “Cancel”.

- **To delete all the items of the list**
  Click on “Cancel All”;
  Confirm the operation if necessary. Wait for the screen refresh.

- **To reset the form**
  Click on “new”.

*For each receiver the calendar function is also suitable to enable the alarm sending procedure only during certain period of time. See Calendar chapter.*

### 3.3.4.3 ALARM LEVELS

The alarm levels are organised as a list of items. Each named level provides to execute the right procedure to transfer the alarm notification to the receiver or receivers. They act just like a filter.

E.g: an alarm belonging to the “Temperature alarm” typology can be differently treated from the “no-link” alarm so as the destination and the kind of message is suitable to a proper information about the alarm event itself. The alarm level also assigns the number of receivers and the transmission mode (Fax and E-mail). It is also possible to switch on/off the status of the onboard relay (only for XWEB500DIN). Check/uncheck AUX1 or AUX2 in the proper page. In the back of the unit you can find the relay outputs.

**WARNING:**

Terminal blocks for relays AUX1 and AUX2 can not be used for switching high voltage loads (24V or higher). Use a low voltage circuit to manage your loads.

The easiest method to work with levels is to define three kinds of alarms corresponding to “Severe alarm”, “Standard alarm”, “Warning”. Each alarm typology, depending on its importance, can be linked to one of this three alarm level to alert different personnel.

It is also allowed to define as many alarm levels as the existing alarm typology in order to transfer complete information about each alarm origin.

Under the device configuration paragraph you will learn how to assign the designed alarm typologies and alarm levels to each instrument.

This multilevel structure gives the maximum flexibility and it comes to solve every kind of alarm management problem.

- **Insert a new Alarm Level and the attributes**
  Click into “Name” and insert the word(s) that better represents the alarm e.g.: "Severe Alarm".

<table>
<thead>
<tr>
<th>Alarm level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select: <strong>-Select-</strong></td>
</tr>
<tr>
<td>Name: <strong>-Enter-</strong></td>
</tr>
<tr>
<td>Receivers</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>7</td>
</tr>
</tbody>
</table>

- **To insert the Receiver**
  Select the Receiver.
  Click the kind of procedure to send the alarm (Fax, E-mail).
Click on “Insert” to add the new item.

- **To modify an item**
  Select the item from the “Selection” roll down menu.
  Modify the appropriate fields.
  Click on “Modify”.

- **To delete an item**
  Select the user to delete.
  Click on “Cancel”.

- **To delete all the items of the list**
  Click on “Cancel All”;
  Confirm the operation if necessary. Wait the screen refresh.

- **To reset the form**
  Click on “new”

- **To use the on-board buzzer**
  Click on “Buzzer”. If the option is unchecked, during an alarm the buzzer will not be activated.

### 3.3.4.4 ALARM TYPOLGY MANAGEMENT

The alarm typology list, designed by the user, groups the common alarm features of the instrument into an unique definition. For instance all the temperature alarms that are not important can be defined by a typology named as “Normal Alarm” while the temperature alarms of the frozen food can be identified by the typology “Severe Alarm”.

The user can assign a typology name for the desired alarm event such as: High temperature, low temperature, High or pressure, open door, compressor oil, Frozen food, etc…

The user can define the accuracy of the alarm description
Each typology can define the following:

- One of the alarm level previously defined to send the alarm.
- The Delay time that defines the minimum duration of alarm. The alarm must be longer to be computed, otherwise the system will only record the event in the alarm historical list.
- The accumulation time that defines the time when the alarm will be sent. This time will be counted only if the alarm lasts more than its delay time.
- For each alarm the user can insert the appropriate word(s) that represent(s) the alarm transmission.

- **To inset a new Alarm typology**

  | Typology | | | |
  |---------|------------------|
  | Select  | Name:            |
  | Level:  | Delay (min):     |
  |         | Accumulation (min): |
  | Fax header | SMS header | email header |
  |         |         |         |
  |         |         |         |

  Click into the “Name” and insert the appropriate word(s) to describe the alarm typology.
  Assign the alarm level procedure under “Level”.
  Define the “Accumulation” time and the minimum activation time or “Delay” of the alarm.
  Insert the appropriate message header into the corresponding fields.

- **To modify the item**
  From “Selection” find the desired item.
  Change the wrong description.
  Click on “Modify”.

- **To delete an item**
Select the item to delete.
Click on "Cancel".
- **To delete all the items of the list**
  Click on "Cancel All";
  Confirm the operation if necessary. Wait the screen refresh.
- **To reset the form**
  Click on "new"

3.3.4.5 QUEUED MESSAGES
The fax message can be sent to a back-up number ("Second fax number"). If the first number is engaged or the line is unavailable, the system tries to send the message to the second fax number.

3.3.5 CALENDAR FUNCTION
The Calendar function is used to define if a function or a single event is active or not in the selected period of time.
Therefore the Calendar is suitable to include/exclude certain period of the day, month or year when it has to interact with some XWEB procedures or for instance if the maintenance personnel is working on the unit.
The resource (or any programmed procedure that the XWEB has to follow) related to a Calendar is available "Enabled" only during the selected periods otherwise it is "Disabled" and it does not work.
The XWEB use the Calendar as filter before activating the resource itself, if the resource is not Enabled in that period nothing happens.
The alarm procedure to inform an Assistance Centre or the light on function can be override by their appropriate Calendar programming.
The number of Calendars is not limited and each Calendar can manage more than one resource.
The Calendar is based on a weekly list extended for all the month, the tile colour shows the function related to that day

The day is divided in:
- **Enabled** → Green colour;
- **Partly Enabled** → Yellow colour;
- **Disabled** → Grey colour.

Disabled day represent the 24 hours where the resource is not active (eg holiday). Enabled and Partly Enabled days can accept the period of activity of the resource.
- Setting the daily period activity for all the week
  (Eg: define Saturday and Sunday as Disabled, Wednesday as Partly Enabled).
Select the appropriate month:
Point the mouse arrow on the rose tile “Saturday”.
Click with the left button and then set the value as “Weekly not Enabled”. The tiles become Grey.

Repeat the operation for “Sunday”. The tiles become grey.

Click with the left button of the mouse on the rose tile “Wednesday” and select “Set As Weekly Partly Enabled”. The tiles become yellow.
Define the period of activity of a day  
(Eg: from 08:00 to 20:00 for Enabled day and from 08:00 to 13:00 for Partly Enabled). 
Under the “Individual Day Time Band” click into “From” and set 08:00 then click into “To” and set 20:00.  
Click on the button “Set for All Enabled” to active the new period for the Enabled day.

All the working days (Enabled) will follow the new times.  
Repeat the same operation to define the new period for the Partly Enabled days but clicking on “Set for All Partly Enabled”.

DAY ATTRIBUTE  
To verify the day attribute point the mouse arrow into the appropriate day and click the right button.
- **Single day setting**
The attribute of a single day can be defined as follow:
Point the mouse arrow into the appropriate day;
Click on the left mouse button and select from the list the new attribute:
  - Set As Enabled → Only that day as Enabled.
  - Set As Not Enabled → Only that day as Not Enabled.
  - Set As Yearly Not Enabled → That day as Not Enabled for all the years.
  - Set As Partly Enabled → Only that day as Partly Enabled.
  - Set As Yearly Partly Enabled → That day as Partly Enabled for all the years.

- **Select a limited period of days**
  To define a common attribute only to some days.
  This allows to set a holiday period for one or more desired months of the year.
  - Point the mouse on the first day desired, click the left button.
  - Keeping the left button pushed move the pointer slightly through the next days to be included.
  - Release the mouse button and select the proper attribute, all the selected tiles will change into the new corresponding colour.

- **Calendar Management**
  Under this section the three button allows to save a new calendar format, load or delete it.
Open New: to create a new calendar. As default Sunday and Saturday are not enabled.
Save Actual: to save the new or modified calendar structure.
Delete Actual: to delete the displayed calendar.
Save As: to save the displayed calendar with a new appropriate name.

3.3.6 DEVICE CONFIGURATION

The configuration of the devices allows to assign the appropriate monitoring system attributes. The configuration is subordinated to the manual or automatic search procedure to create a list of the available instruments.
For each kind of device XWEB will show only the specific information of the controller itself and the attributes of the available digital and analogue inputs of the instrument. Only this part of configuration admits the association of the categories previously defined such as the alarms, typologies and time recording.
If during the configuration it is necessary to use a category to associate to a new feature of the instrument but the category it is not present, the user can step back into the Categories menu, create the new category and then restart with the device configuration.

3.3.6.1 SELECT A DEVICE

Please go to “Configuration” -> “Devices” roll-down menu. This window will appear:

By using “Device” drop-down menu you can select which controllers to show.
If the instrument has not been already renamed the identification name is: “New_Model-name” where:

- “New” means that the name has been assigned automatically by the system;
- “Model-name” define the instrument model.

Instead of “xxx_New_Model” the user can insert the new appropriate name for this instrument.

3.3.6.2 ASSIGN THE NAME OF THE CONTROLLER

After selecting the device, click into the “Name” field. Insert the new name such as “Frozen food_001”. Assign the proper sampling “Interval”, decide if you want to read and record data from this instrument by checking/unchecking “Data Reading” and “Recording” boxes.

“Data Buffer” is an useful function that stores with the maximum speed available lots of data values (regardless of sampling interval) when an alarm occurs. Ten minutes of data values before and 5 after the alarm are recorded at maximum speed if “Data Buffer” box is checked. Finally if you need to synchronize the on-board RTC of the controller, select RTC.

Click “Modify” now or at the end of the whole configuration.
3.3.6.3 **ASSIGN THE CATEGORY TO THE DEVICE “DEVICE CATEGORY SETUP”**

Be sure of having selected the right instrument under the “Device” menu. Depending on the instrument model there are different available categories to define the attributes of the instrument itself. If you do not find the right one maybe it is not defined or it is not available for that instrument. By itself XWEB, after the recognising procedure, assigns the default categories (if you checked the box in category window) to the devices connected to the RS 485. To change the category click inside the field and select the appropriate item.

Click “Modify” now or at the end of the whole configuration.

3.3.6.4 **ASSIGN THE ALARM TYPOLGY**

<table>
<thead>
<tr>
<th>Origin</th>
<th>Name</th>
<th>Typology</th>
<th>Sh.</th>
<th>Rec.</th>
<th>Send</th>
</tr>
</thead>
<tbody>
<tr>
<td>No link alarm</td>
<td>No link alarm</td>
<td>no link</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Low Value P1</td>
<td>Low Value P1</td>
<td>Temperature Alarm</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>High Value P1</td>
<td>High Value P1</td>
<td>Temperature Alarm</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Error P1</td>
<td>Error P1</td>
<td>Generic Alarm</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

Be sure of having selected the right instrument under the “Device” menu.

**ALARM ORIGIN**: depending on the instrument model there are different available alarms, if you do not find the right one it means that it is not available for that instrument.

**NAME**: each alarm can be assigned with an appropriate label defined by the user, this label is also used when it is displayed by the system. Click inside the “Name” and modify it.

**TIPOLOGY**: links alarm type to the proper Alarm typology. If you do not find the proper action in it, step back to the Alarms definition to insert the new features into a new alarm typology.

**SH** (Show): when it is enabled the alarm is showed in main page.

**SND** (Send): when it is enabled the alarm is sent by XWEB.

**REC** (Recording): when it is enabled the corresponding alarm is logged.

Click “Modify” now or at the end of the whole configuration.

3.3.6.5 **DEFINE THE DIGITAL, ANALOGUE INPUTS AND THE STATUS**

The middle area is dedicated to the analogue inputs (probe), setpoint, digital inputs, devices status, and commands assignments.
NAME: The first time each name is displayed by following the internal XWEB archive of standard feature of the instruments. Each definition can be renamed when necessary to give the proper meaning. Beware of the difference between integer and decimal value. Instruments are factory preset to decimal point, so if you change this value to integer you need to make the same change inside XWEB. All default labels are intended as decimal, when you change to integer a postfix “-I” is shown. It may happen that you move to integer using advanced properties (see Appendix A), then coming back to label name and changing it without using “-I” you completely loose the information you are displaying integer. This may be a problem because when you come back to advanced section there is no more difference between decimal and integer.

To change a name simply click inside its field and modify it.

Unit: The analogue input is followed by the proper unit of measurement, change the unit by clicking in it then insert the new value. Beware that in this window you can change only the label of the unit of measurement. In Advanced section you can change the behaviour of the instrument (e.g. Celsius or Fahrenheit degree)

Click “Confirm” now or at the end of the whole configuration.

- Delete one device from the list
  Stop acquisitions. Select the instrument to delete.
  Click on “Cancel” in “Action” menu.

- Advanced function
  The “Advanced” key allows to reach another configuration area dedicated to the instrument setup. This area is very dangerous because this configuration defines important features that can badly affect the unit if not properly set.

  Take care of this advice and ask authorised personnel before trying any kind of setting.

  You can find more complete information in Appendix A.

### 3.3.6 CLONE FUNCTION

This function is intended to let the user save a lot of time during the first setup of the XWEB. By using this function the system will broadcast the current instrument setup to all the other that are compatible. The compatible instruments are only the ones who belong to the same model. In this situation the user is requested to made only one setup, then using “clone” button in few seconds (depending on the total number of instruments) the configuration will be applied to all the other controllers.

In the first step you are required to make a complete setup regarding both standard and advanced section.

When you are ready, please go to “Configuration” -> “Devices” roll-down menu. This window will appear:
In the upper part you can see information concerning the name of the instrument that the system will use as base model (“Source device”).
In our example we have a XJP60D whose name is “Acq. module 1”. It is possible to change the name of the “Target device” by clicking in the field “Name”.
By clicking “Clone” button XWEB begins to broadcast this setup to all the compatible instruments. Once it has finished a summarising window will appear. It is also possible to decide to clone both the typology and the recording interval by ticking the corresponding columns.

3.4 STARTING MONITORING DATA

At this point it is possible to start the server. Click on “Modify”. This new window will appear

Check/unchecked the proper action and push “Apply”.

| Data reading: | XWEB will only read data coming from RS 485. |
| Recording: | XWEB will record data coming from RS 485. |
| Alarms TX: | XWEB will send alarms coming from controllers. |
### 3.5 DEVICES MENU

In this menu you can find all the web pages that allow the final user to interact with the controllers connected to the RS485.

#### 3.5.1 SINGLE VIEW

Select SINGLE VIEW to show all the data corresponding to a selected instrument. You will be informed about probe values, digital inputs, device status, alarms for all the time you are connected.

- **How to select a device and show the data**

![Device Filter](image)

The devices can be selected using the Device filter in order to reduce the number of items of the search. From the “Device filter” roll down menu select the category to which the instruments belong to. Then, under the “Select a device” menu select the instrument you are interested in. After some seconds the whole situation of the instrument will be loaded and displayed. The information is divided in horizontal rows such as analogue inputs, Set points, digital inputs, device status, outputs status, alarms and commands. A grey label means a function not active at that moment, on the contrary a blue label means an activated function.

#### Analog Inputs

<table>
<thead>
<tr>
<th>Device</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Room (Pt1)</td>
<td>25.4 °C</td>
</tr>
<tr>
<td>Evaporator (Pt2)</td>
<td>27.9 °C</td>
</tr>
</tbody>
</table>

#### Set Point

<table>
<thead>
<tr>
<th>Device</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Point</td>
<td>35.0 °C</td>
</tr>
</tbody>
</table>

#### Digital Inputs

<table>
<thead>
<tr>
<th>Device</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Door Switch</td>
<td>NOT ACTIVE</td>
</tr>
<tr>
<td>Generic Alarm</td>
<td>NOT ACTIVE</td>
</tr>
</tbody>
</table>

#### Device Status

<table>
<thead>
<tr>
<th>Device</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>On/Off</td>
<td>ACTIVE</td>
</tr>
<tr>
<td>Defrost</td>
<td>NOT ACTIVE</td>
</tr>
<tr>
<td>Keyboard</td>
<td>NOT ACTIVE</td>
</tr>
<tr>
<td>Energy Saving</td>
<td>NOT ACTIVE</td>
</tr>
</tbody>
</table>

#### Output Status

<table>
<thead>
<tr>
<th>Device</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Defrost</td>
<td>NOT ACTIVE</td>
</tr>
<tr>
<td>Fan</td>
<td>ACTIVE</td>
</tr>
<tr>
<td>Cooling</td>
<td>NOT ACTIVE</td>
</tr>
</tbody>
</table>

#### Alarms

<table>
<thead>
<tr>
<th>Type</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low Value Pt1</td>
<td>NOT ACTIVE</td>
</tr>
<tr>
<td>Error Pt2</td>
<td>NOT ACTIVE</td>
</tr>
<tr>
<td>Error Pt3</td>
<td>NOT ACTIVE</td>
</tr>
<tr>
<td>External Alarm</td>
<td>NOT ACTIVE</td>
</tr>
<tr>
<td>EEPROM Failure</td>
<td>NOT ACTIVE</td>
</tr>
</tbody>
</table>

#### Commands

- Device ON
- Active Defrost
- Keyboard LOCK
Remember that you are looking at a still page therefore the instrument information is loaded and displayed then there is no more data coming from the server. The screen refresh with the new data can be executed automatically by selecting the “Auto” box and decide the updating interval by clicking into the time box on the right side. Click on “Update” button to update the window with manual procedure.

- **Change set point function**
  You can change on the fly the set point value by clicking inside the box:

  ![Set Point Table]

  A window will appear, asking you the new value, confirm the new set point by clicking OK button.

- **Commands**
  The last stripe of information contains the available commands for that instrument. Use them to operate on the instrument. Take care of the operations you make with commands.
  Click on the interested function button, after sending the command the information of the new status will be automatically updated and displayed.

  ![Commands]

  Beware that “Stand By” commands turn off the instruments.

### 3.5.2 RUN TIME

The run time function provides to display into a unique window many devices together. This is dynamic page and the data showed are updated in real time (the period depends on the number of instruments).

*This page based on the modern Java programming language, therefore it is necessary to have the Java Virtual Machine installed on the client PC. Normally the JVM is already installed into the PC operative systems, (if not present see Minimum requirements section in this manual). A warning message will propose you to use it. Accept it, the software applet is guaranteed free from viruses.*

In the Home page select the “Run time” from the “Devices” menu. The first part is referred to the selection of the Category of the devices installed in order to save loading time, while the selection “All” will show all the instruments. After selecting the proper category, XWEB begins sending data to your PC. The first time you load the RUN-TIME windows, you are requested to accept the start of JVM program. All applets that use JVM are certified by Dixell. Please answer to the warning windows by clicking on the “OK” button (the message text depends on the release of JVM and on operative system of the PC). Then the Run Time page will start to display the selected devices with their information. If one or more instruments have an active alarm event, the message box will indicate the alarm situation with a red “Alarms” label. If whole situation of the instrument displayed is normal, the message box will show “Device(s) OK !” in green colour.
Each device is represented by an horizontal row that includes as many rows as many information are available from the instrument.

For each row, the blue bar contains the address and the instrument name followed by the typology to which the instrument belongs to. At the end of the blue bar there is the command box “Sel”.

The second row of a main row contains the set-point and the analogue inputs like the probe values or other peculiar information of the instrument read-outs such as the electrical measurements of a net analyser.

The third row of a main row is divided in three parts: the first area contains the icon symbols of the instrument status, the second area contains the icon symbols of the instrument outputs (relays) and the third area shows the digital input status with their complete description.

An icon not surrounded by a blue square means the corresponding function is not active. The active status of an instrument function is represented with the corresponding blue icon.

More information about the icon function can be read, pointing the mouse arrow over a single icon, on the left down corner of the browser border.

- **Devices in alarm**

  In case of alarm event the corresponding instrument is signalled with the red blinking description. Immediately also the message box, on the top of the browser bar, will indicate the alarm situation with a red “Alarms” label.

  Find the complete alarm description clicking on the row blue bar. A pop up message box will appear, inside you will find the list of the actual alarms that also includes the starting date of each event.
- **Send the commands to devices**
  From the run time page you are allowed to interact with the instruments by sending commands to them. The user is requested to select the instrument or the instruments to which the command has to be sent. To do that click into the “Sel.” box to select the instrument.

On the right top side of the browser border will appear a Toolbar which contains the Commands button and the possibility of selecting or deselecting all the instruments together. To define the command to send click on “Commands” and immediately a choice list will appear. For multiple selection of some or all instruments the available commands will be only the common commands among the instrument selected. Select the command and click on “Send” button. Before proceeding a message box will tell you how many instruments are involved.

The popup box also shows, with a blinking message, the status of the operation just executed and then
also the ending report result.
If an error occurs the corresponding diagnostic message is displayed.
3.5.3 PARAMETERS

The Parameter function allows management of the parameters of a selected device. The parameters can be displayed and modified. From the Home Page, select the “Parameters” item from the “Devices” menu. From the “Actions” select one of the following functions:

- **Load from Device:** to load and display the parameters from a device;
- **Load from File:** to load and display the parameters from the Hard Disk of the Client PC;
- **Write on Device:** to updated the displayed parameters into the selected device;
- **Write on Devices:** to updated the displayed parameters into the selected devices;
- **Save on File:** to save the displayed parameters into the Hard Disk of the Client PC.

To show the parameters of a device select "load from device" from the “action” menu: Use the filter mask to limits the range of the device selection:

- **DEVICE TYPOLOGY:** To filter among the different typologies ("All“ includes all the instrument);
- **Select a Device:** To select the desired instrument;
- **Select a Group:** To defines only a limited group of parameters to load;
- **Select “Menu”:** To defines which is the parameter level to use (Pr1, Pr2, All).

After filling the filter mask, click on “Read” button to load the parameter from the instrument to the client pc.

*The loading time depends on the number of parameter selected.*

<table>
<thead>
<tr>
<th>LABEL</th>
<th>DESCRIPTION</th>
<th>ACTUAL</th>
<th>NEW</th>
<th>MIN</th>
<th>MAX</th>
<th>UM</th>
<th>Pr</th>
<th>SAVE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hy</td>
<td>Differential</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LS</td>
<td>minimum Set Point</td>
<td>10</td>
<td>10</td>
<td>8</td>
<td>12</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>US</td>
<td>Maximum Set Point</td>
<td>40</td>
<td>40</td>
<td>35</td>
<td>45</td>
<td>*F</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ndS</td>
<td>Outputs activation delay at startup</td>
<td>0</td>
<td>3</td>
<td>1</td>
<td>55</td>
<td>min</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ac</td>
<td>anti Short cycle delay</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>cdf</td>
<td>Compressor ON time during fast feeding</td>
<td>0:00</td>
<td>0:00</td>
<td>0:00</td>
<td>0:00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>cin</td>
<td>Compressor ON time with faulty probe</td>
<td>15</td>
<td>15</td>
<td>10</td>
<td>20</td>
<td>min</td>
<td></td>
<td></td>
</tr>
<tr>
<td>coF</td>
<td>Compressor OFF time with faulty probe</td>
<td>30</td>
<td>30</td>
<td>25</td>
<td>35</td>
<td>min</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cM</td>
<td>Measuring unit</td>
<td>°F</td>
<td>°F</td>
<td>°F</td>
<td>°F</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RES</td>
<td>Resolution</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lcd</td>
<td>Display visualization</td>
<td>P1</td>
<td>P1</td>
<td>P1</td>
<td>P1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set</td>
<td>Set point</td>
<td>35</td>
<td>35</td>
<td>35</td>
<td>35</td>
<td>°F</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The parameter table is defined by these columns:

- **Label:** The parameter label as described into the instruction manual of the instrument itself;
- **Description:** Description of the parameter function;
Actual: Actual value of the parameter loaded from the instrument;
New: New value of the parameter decided by the user;
Min /Max: Minimum and maximum limits available for that parameter;
UM: Unit of measurement;
Pr: Parameter level of the parameter itself;
Save: Selection box to enable the parameter saving.

To change a parameter value
To insert the desired value of a parameter click into New box.
Depending on the kind of parameter, it is possible to insert the value or select it from a drop-down list of available values.
To confirm the new value introduced click the mouse outside the “New” box area.
It is not allowed to set a value exceeding the minimum and maximum limits. In any case a wrong value is signalled with violet background colour of the box itself.
The user can change one or more parameters before sending back the new list.

To change the programming level
Select 1 level or 2 level under the Pr column.

To send the new parameter map to the instrument
After modifying the parameters, select “Write on Device” from the “Action” menu.
To confirm the operation click on the Ok button into the message box.

To send the new parameter map to the instruments
The displayed parameter map can be sent to many compatible devices.
Select “Write on Devices” from the “Action” menu.
The message box will show all the compatible instruments with that map.
Select which instruments are included (or “All”).
Click on the “Write” button to start the procedure.
A warning box will appear reminding you how many parameters you are changing.
Each writing operation is described into the message box.
At the end of the operation a conclusive report will be showed.

To save the parameter in your Client PC
The parameter can be saved into the hard disk of the Client’s PC, reloaded and used for other parameter programming.
With a displayed parameter list, click on “Save on File” from the “Action” menu.
Select the “Save” box to include the interested parameters.
Click on the “Save” button situated in the top right position.
Click on “Save All” button to save the complete list.
Some operative system installed into the Client PC can require to “Save” before proceeding.
From the next message box insert the name of the parameter map and then click on “Save”.

To load a parameter map saved into your Client pc
Click on “Load from File” from the “Action” menu.
Use the find button to search among the files of the message box.
Click on find or insert the file name including the path. These system always proposes the last folder used during the last saving.
Confirm the name of the file to load.
Click on “Upload” to proceed.

To print the displayed map
Click on “Print” from the “Action” menu.
Use the message box to select the print properties.
Confirm the printing to proceed.
3.5.4 LAYOUT FUNCTION (ONLY FOR XWEB500DIN)

With this function it is possible to build up a Layout view of the system been monitoring. The user can creates as many layers as he needs and place important information and data value coming directly from the instruments. XWEB uses 2 different menus to deal with Layout: one is “Layout Edit”, the other is “Layout Viewer”. Both of them use web-technology, so Java Virtual Machine is needed. More importantly that all data information is stored inside the XWEB server and it is pushed dynamically to your client. This means that according to the connection speed pages could take different loading time. The Editor is the most important part, we start discussing it first.

We strongly suggest to set client PC resolution to 1024 x 768 pixels and use the same resolution for the background images.

3.5.4.1 LAYOUT EDITOR

To start “Layout Editor”, go to “Devices” then choose “Layout Editor”. If this is the first time you run the Layout, a blank windows will appear.

The available menus are:

File Submenu:

- **NEW LAYOUT**
  This function is used when you want to start a new Layout. Beware that the system can only manages one layout per time. There is no possibility to save a Layout with a particular name and then build up a new one.

- **SAVE**
  This function allow you to save the changes done till now. Beware that the system can not go back to a previous save, only the last one is available.

- **LOAD**
  Load the last Layout

- **EXIT**
  Closes the Editor.
Layers Submenu:

- **ADD LAYER**
  It is used to add a new layer to the layout. Selecting it this windows will appear:

User has to compile “Name” with any text value, then he can choose the background colour and also a background image pushing “Image…” button. In this case a new window will appear:

Choose an image and press “Ok”. When you use images the system has to send them to your client. Depending on the speed of the connection the download procedure may take up to some minutes. According to the client screen resolution the system will load up a new page. The real dimensions (width and height) come from the monitor setting of the client itself. The system later is capable of dynamically resize this value to show images and layers in a proper format. We strongly suggest making some test before proceeding with the complete layout design. Usually images are taken with a digital camera. Beware
do not confuse this resolution value (e.g. megapixel 3, 4 or more) with the one of your monitor (800x600, 1024x768 pixels). When you take a digital picture, your camera saves it according to its setup. Once you download these photos to your PC you need to resize them to the value you want to use in the layout.

Example Table 1

<table>
<thead>
<tr>
<th>Digital Picture resolution</th>
<th>File size RAW</th>
<th>File size JPG highest resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>2048 x 1536 (3-megapixel)</td>
<td>9MB</td>
<td>~1.10MB</td>
</tr>
<tr>
<td>2272 x 1712 (4-megapixel)</td>
<td>12Mb</td>
<td>~1.47MB</td>
</tr>
<tr>
<td>2592 x 1944 (5-megapixel)</td>
<td>15MB</td>
<td>~1.82MB</td>
</tr>
</tbody>
</table>

With a image editing software you can resize all the picture to the proper size. Size also means kilobytes to download for the client. We suggest to use images not bigger than 40~50 Kb. Of course if you have a fast connection you may exceed this value. File format supported are: JPG and GIF. We strongly suggest to use JPG due to its better compression factor. As an example you can refer to the following table chart:

Example Table 2

<table>
<thead>
<tr>
<th>File Resolution</th>
<th>Compression ratio</th>
<th>File Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>800 x 600 (outdoor image)</td>
<td>45%</td>
<td>64Kb</td>
</tr>
<tr>
<td>800 x 600 (outdoor image)</td>
<td>65%</td>
<td>44Kb</td>
</tr>
<tr>
<td>1024 x 768 (outdoor image)</td>
<td>45%</td>
<td>98Kb</td>
</tr>
<tr>
<td>1024 x 768 (outdoor image)</td>
<td>65%</td>
<td>67Kb</td>
</tr>
</tbody>
</table>

Actual file size, if you use JPG compression, depends on the picture you are compressing. Different pictures with same compression ratio and same file resolution, may have different file size.

- **NAME**
  It is used to change the name of the layer:

  ![Insert New Name](image)

  Insert the new layer name and push “Ok”.

- **BACKGROUND COLOUR**
  It is used to change to background colour of the page. Use the drop down menu to make a choice.

  ![Select Color](image)

- **BACKGROUND IMAGE**
  It is used to change the actual background image or to set an image as background. When you choose this option, the following windows will appear:
Choose an image and press “Ok”. When you use images the system has to send them to your client. Depending on the speed of the connection the download procedure may take up to some minutes.

- **REMOVE IMAGE**
  It allows you to cancel the background image, if present.

- **SET AS MAIN**
  This function is very important. With this feature you can decide which is the homepage of the layout. Each time an user will load the layout viewer this is the page that firstly appears.

- **DELETE**
  It allows the user to remove the actual layer from the layout.

**Insert Submenu:**

- **DEVICE**
  It allows you to place a real Instrument directly linked to the RS 485 serial line
  The following windows will appear:
With the first drop down menu you can filter the instruments, with the second one you select the instrument you want to show in the layer. A new windows will appear:

Name of the instrument.

You can check/uncheck the name. It is also possible to change:
BG = background colour
TX = text colour
SZ = font size

Analog values.

You can check/uncheck the values or modify them. It is also possible to change:
BG = background colour
TX = text colour
SZ = font size

Digital Inputs.

You can check/uncheck the values or modify them. It is possible to let them blink (if active) or to change:
BKG = background colour
SZ = font size

Outputs.

You can check/uncheck the values. It is possible to use icon or animated square. User can also modify:
BKG = background colour
SZ = font size

In the output section if you choose “Icon” the system will show a small drawing with the following meaning:

Example Table 3

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>🌫️</td>
<td>coloured icon rounded with blue square</td>
<td>On</td>
</tr>
<tr>
<td>🌫️</td>
<td>Gray icon</td>
<td>Off</td>
</tr>
</tbody>
</table>
In the output section if you choose “Motion” a new window will appear:

User has to choose the rectangle property:

<table>
<thead>
<tr>
<th>Label</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>BG</td>
<td>Rectangle background colour</td>
</tr>
<tr>
<td>FG</td>
<td>Rectangle foreground colour</td>
</tr>
<tr>
<td>PX</td>
<td>Line thickness in pixels</td>
</tr>
</tbody>
</table>

With the first left button mouse click you place the control in the layer, then point to the top left corner of the rectangular area, hold down left mouse and drag the pointer to the bottom right corner. Release left mouse button move the rectangular area to centre it and push left mouse button once. In the following example you can see a compressor rounded with a blue/red rectangular area. We also used “load 1” icon:

- **SENSIBLE AREA**
  It allows to define a particular zone that can be linked to a layer. Mouse pointer change itself to a finger-icon when it is moved on these areas. The following window will appear:

  It is possible to choose a transparent area or a coloured one. We suggest to use the first one when the background is an image. The procedure is the same as the one highlighted above in the motion rectangular area.
- **TEXT AREA**

It allows you to insert a text area inside the layer. We suggest to use this function each time you need to write something inside the layer. To not try to write text inside background image with your editing software instead use text area.

![Text Insertion](image)

Insert your text here

By using the four drop down menu, choose: font type, style, size and colour.

- **RECTANGLE**

This function is useful when you want to highlight some area inside the layer.

User can choose the rectangle colour and the shadow effect. The procedure to draw the rectangular area is the one described above Device section.

![Rectangle](image)

<table>
<thead>
<tr>
<th>Shadow effect</th>
<th>Without Shadow</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Shadow" /></td>
<td><img src="image" alt="Without Shadow" /></td>
</tr>
</tbody>
</table>

Off course user can combine this function with text area and build up his own button-like graphics. Then with sensible area function you can link it to a specific layer. Here it is an example:

![Chiller Layer](image)

- **DATA OUTPUT EVENT**

This tool adds a HACCP printout button on the Layout. To use this function it is compulsory to have added a HACCP printout on the Scheduler (see §3.3.3.1 Printing events). The following window appears:
Choose the name of the printout defined in the “Scheduler” (e.g. STAMPE). Define a name of the printout (e.g. “stampa HACCP”). Setup the button (test, colour, size) and the security code. Press “Place”. Please notice that on the “Scheduler” it is possible to create e-mail, fax and printouts. If the HACCP printouts events are not set, it is not possible to have the Layout printouts button.

Images Submenu:

- **SEND TO SERVER**
  It allows you to store inside the hard-disk of XWEB all the pictures or drawings you want to use. Do not forget that we are working with web-technology and XWEB acts as a server. In your PC you store temporarily the data later you will upload to the server.

  From the left sub-windows you can browse your hard-disk to find the image you want to upload. Once you find it, select it and push “>” on the central portion of the window.

  When you push “Send” the system first opens a windows to inform you about the upload procedure, once it is complete a new summarising window will appear. Close it by pushing “Ok”.

- **DELETE FROM SERVER**
  It allows you to delete unused images, simply choose the image to delete from the list, then push “Ok” button.

- **DOWNLOAD FROM SERVER**
  It allows you to download an image to the hard disk of your computer. Once you have selected an image, push “Ok”. Standard Windows file manager will open.
Layout Submenu:

- **START**
  It allows you to test your layout. Once you push this button the editor transform itself in the viewer. You can have an overview of the layer with real data coming from the instruments you have selected.
- **STOP**
  This function interrupts the start function described above.

Window Submenu:

- **WINDOW NAME**
  Let you choose among the available layers.

3.5.4.2 LAYOUT VIEW

With this function the user can use the layout previously prepared via “Layout Editor”. Beware that the final user can interact with the real application if you used “Global command” function (see the above point P).
Of course Java Virtual Machine is needed. Your browser helps you during the download procedure. Quite probably the image you uploaded will not change frequently, so once they all are in the browser’s cache next time the load time will be faster. According to this function please check if your browser settings support cache. You can do this by clicking “Tools” menu, then “Internet Options” general TAB.

3.5.5 GLOBAL COMMANDS FUNCTION (ONLY FOR XWEB500DIN)

It allows you to place in the layer a command-button and use it to send command to a particular instrument or to a range of them. We do not describe here again all the functions that are available also in the layout.

3.5.5.1 GLOBAL EDIT

In the homepage, go to Devices and choose “Global Edit”.
Go to insert menu and choose “Global Command”:

Here select the proper category. Once you have made your choice, the system loads up a new window.

A summarizing window will appear:
You can check/uncheck manually the instruments or you can use the Select/Deselect All. Then push "Continue".

By pushing "Continue" the system makes a check to show you only the compatible commands to the instruments you have selected.

Choose the command/s you want to send by checking it, then give it the proper meaning by using the blank field.

**BG:** button background colour  
**TXT:** button text colour  
**SZ:** button font size  
**Dim:** button size  
**Code:** check it if you need a password protected command

Here it is some button size examples. All screen captures are made at 1280 x 1024 pixels, standard resolution for a 17" LCD.
Once a button is password protected, each time someone push it, this window will appear:

If you insert a wrong code, the field reset itself. You can continue inserting a code until you press “Exit”.

- **GRID**
  It helps you to align all the objects you want to place in the layer. By choosing this option you can also select the grid colour.

3.5.5.1.1 **DIGITAL INPUT SENDING COMMANDS**

It is possible to send a set of command to a specific range of controller. The user must setup the “polarity” of the contact. This can be achieved by means of “Close contact setup” or “Close contact setup”.

---

1592028000 XWEB300D_500_500D opr GB r2.1.1 2012.11.05.docx  XWEB500/300  77/113
The status of the contact can be enabled or disabled.

Use the device filter to add the controllers to the digital input command sending feature.

Choose which command you want to send.
3.5.6 PERFORMANCE METER (ONLY FOR XWEB500DIN)

The value added by this new software tool is remarkable: possibility to check the correctness of the compressor rack size; possibility to check the proper functioning of each device; statistics data collection. Firstly go to “Data” then “Performance meter”. Secondly go to “Class” menu and then choose “Create class”. Fill in as the following:

**Class Name:** the name of the class, usually corresponds to the name of the typology you have already created.

**Typology Filter:** let you filter between different typologies.

**Set point:** let you choose between more than one set point (if available)

**Probe:** let you choose which probe you want to use to calculate the average temperature.

**Sampling (min.):** period of time to use for collecting data samples

**Avg. Factor:** this number will be multiply by the “Sampling” to obtain the average time interval length. This value is computed to calculate the average value for the interval.

**Normal Range (min. and max.):** the user can add a temperature interval. When temperature is out of this range the slide bar will be coloured with red.

**Defrost offset (min.):** elapsed time to count before starting computing the maximum temperature reached after a defrost.

The following picture shows how XWEB computes the maximum value of temperature (Max) and the maximum value after a defrost (Tdef). The former is computing by subtracting the time interval [A,B]. The latter depends on the parameter “Defrost Offset”, so the system computes Tdef by subtracting the time interval [A,C].
Once you fill in the above module, you can proceed selecting the controllers, then press “Create”. To show a class please select “Performance” then “View Class”:

**Class:** let you choose between the class you have created before

**Circular Data Interval:** the sampled data comes from the circular archive

**Main data interval:** the sampled data comes from the main archive. In this case the user must choose a proper interval

**Show:** by pressing this button the system will start to compute all the sampled data.

After some moments this new window will appear:
The information provided is: in the past two days (between 24/06 and 26/06, look at “period”), the system calculated the average set-point “SP1” and the average temperature “Avg”. Moreover it displays the minimum, the maximum value and the maximum value of temperature after a defrost (Tdef). Finally it shows the percentage of cool “%Cool”. The latter is the most important value, it is calculated by using the following math formula:

\[ %\text{Cool} = \frac{T_{\text{COOL}}}{T - T_{\text{DEFROST}}} \times 100 \]

Where:
- \( T_{\text{COOL}} \) = cool time (corresponding relay open), in the selected time interval or the average %
- \( T \) = time interval selected
- \( T_{\text{DEFROST}} \) = defrost time in the selected interval

To complete the information provided this tool show also a horizontal bar and a Legenda. If the user moves the mouse pointer above this area, the cursor will show the temperature and the data.
3.5.6.1 INTERPRETING THE %COOL

From an ideal point of view the highest the percentage is, the better the compressor rack has been tuned. Of course if many devices work with a percentage next to 100% it means that quite probably during the worst condition case some devices may fail to receive the correct amount of cooling. Use the data provided by “Performance meter” according to your experience. This software tool can be useful also when the majority of the devices (belonging to the same typology) work within a certain range and only one reports a different value. Quite probably that one is not working properly.

3.6 CRO (ONLY FOR XWEB WITH CRO)

Dixell, thanks to its experience in the industrial refrigeration market and even more important, thanks to the tight relationship with the customer, has developed a specific module intended to energy-saving politics. C.R.O. basically works with 2 parameters: suction pressure of the compressor rack and the worst case cabinet. The former is detected via a XC1000D controller (ver.1.1 or higher) and XC600CX by Dixell, the latter is computed according to a special algorithm based on the time-switching of the solenoid relay.

This propriety algorithm mixes together into a winning software tool the complexity of the refrigeration system and the easy parameter programming of the user interface. Moreover, once again the software is a JAVA APPLETT, it means no need to install a PC software. Data depends on the seasonal period and varies from installation to installation. To start the C.R.O., go to “Supervising” then C.R.O. The following windows appears:
To use the C.R.O. you must add a class of . XWEB500 will extract from this controllers data to calculate the special algorithm. Go to “Class” menu and create a new class definition..

Open “Operation” menu, the following window appears:

The C.R.O. to better manage the availability of the refrigeration power, it modifies the set-point of the normal temperature compressor rack controller. Execution interval set when the new set-point will be applied to the compressor rack. Back analysis interval set how far in the past the analysis must retrieve its data. Defrost
check interval can be used as a check if the controllers really defrost. If there is no defrost for a period of longer than this parameter, the C.R.O. will add a warning to the graph report. Reference class is the group of controllers involved in the data analysis of the worst case. Controller is the device made by Dixell that controls the compressor rack. Set point let the user choose the right set-point (usually the suction set-point). The parameter for the worst case calculation (represented in percentage), let the user define a threshold for the C.R.O.: below the value there is no action, above the algorithm sends the new set-point. Dead band is set across the worst case set parameter and defines a neutral band: here inside no action is starter. The algorithm to modify the suction pressure needs to know the initial value of this figure. The Initial pressure parameter is used to set this value. Min./Max. suct. Press. Parameters are security limits for the C.R.O. We strongly suggest to add this entries to prevent the algorithm to set set-point values out of bound. Release and Call gain parameters control the new set-point value according to the following formulas. If the real-time percentage is below the one setup in worst case set (dead band is computed), the new set-point is:

\[
Set_{new} = Set_{old} + \Delta\% \cdot \frac{RLS_{gain}}{1000}
\]

\[\Delta\% = (\text{real-time percentage}) - (\text{worst case set percentage})\]
\[RLS_{gain} = \text{release gain}\]

If the real-time percentage is above the one setup in worst case set (dead band is computed), the new set-point is:

\[
Set_{new} = Set_{old} - \Delta\% \cdot \frac{CALL_{gain}}{1000}
\]

\[\Delta\% = (\text{real-time percentage}) - (\text{worst case set percentage})\]
\[CALL_{gain} = \text{call gain}\]

The real-time percentage is the worst percentage present in the installation according to the quantity of cool power requested by all the controllers during the back analysis interval.

Finally it is possible to simulate the set-point modifications: select acquire data only. To activate the C.R.O. press enable engine. To deactivate the C.R.O. press disable engine. To view the graph report, go to view menu.

### 3.6.1.1 GLOBAL COMMANDS

This function allows the user to load a window containing all the global commands previously defined in the “Global Edit”. In the main page go under Device menu and choose “Global Commands”.

### 3.7 DATA MENU

You can access data information from the roll-down menu “Data” -> “Graphs”.

Graphs is a file containing all the instrument data recording, the time interval used for these recordings is defined into the category “Recording interval”. This archive grows time by time depending on the number of instruments and it can become very large occupying the available memory contained into the server.

### 3.7.1 DISPLAY THE GRAPHS

With “Data” menu you can access Graphs section, then select the desired controller from the filter lists of the Device typology. After selecting the controller, the screen will show all the available data which the instrument is provided with.
The first information about the archive shows into “Available Interval” the first and the last recording date, while the “Select Interval” includes the period you can decided to show. If necessary, modify the Select Interval period.

Longer is the time interval to show, longer the loading time needed to show the data graph. For a first analysis select a time period not so wide but centred on the target of your interest, this ensure higher graph precision. You can also act on “Graph Density” parameters to decide if you need all data samples. This feature is very useful if you are connected via modem at a slow speed.

You have many rows: Analog Input – Setpoint – Digital Input – Output Status – Devices Staus - Alarm. The number of the rows depends on the controller type. For each of them you can graphs as many values as you want. The only limitation is 3 analog values and 2 digital ones.

For each selection is possible to decide the colour of the line that will be represented. It is also possible to group the analogue inputs into a unique graph or to display them into separated ones. For example if you want to display all data using only one graph, select for each value AG1 from the roll-down menu, then in “Graph labels” write some words reminding you the meaning of the graphs. On the other side if you want to display the values in different graphs, you have to chose AG1 for the first values, AG2 for the second and AG3 for the third. Remember that each graph can be renamed by the user with an appropriate name into the corresponding “Graph Labels” situated into the low side of the page.

Before clicking the command “View” it is possible to define the graph density to decide the resolution of the lines and recordings. Select the box “Graph Density”. Higher is the value of this parameter better will be the graph resolution, but longer the downloading time from the XWEB.

Now Click on “View” to start the transferring process of data from the XWEB to your PC. The displaying structure is based on a Java Applet and the Java Virtual Machine program installed into the remote PC that computes the data coming from the XWEB.
Depending on the Virtual Machine version installed a message to accept the term of use will appear during the operation. Dixell S.r.l. guarantees that the software is free from viruses and the request can be accepted.

The counter signals shows the status of the data you are downloading

At the end you will see the graph.

- **Zoom in/out procedures**
  Before executing the zoom it is necessary, if there is more than a graph displayed, to select the desired graph.
  Click, with the left button of the mouse, into the top bar of the information of graph itself.
  To zoom in you just have to keep pressed to left mouse button.
  To zoom out you just have to keep pressed to right mouse button

- **Zoom into an area**
  To enhance the portion of a displayed graph click and keep pressed the left button of the mouse on the hypothetical top-left corner of the area to zoom.
  Than drag the mouse down to the low right corner to complete the window to zoom. If the selected area have not the proper dimensions click one time outside the area itself to abort the zoom, then repeat the operation to select the area to zoom.
  Otherwise, if you click one time with the left button inside the selected area, immediately this area will be zoomed to the borders of the graph.
• **Back to the original size**
  To resize the graph to its original dimension select from the “Scale” menu the “Reset Size” option.

• **Manual Scale**
  The first time the graph is displayed with an “auto scale” function defined by highest and lowest peek and the whole interval time selected.
  Do define a personal scale of the graph view select from the “Scale” menu the “Manual Size” item.
  The next windows will show the X and Y scale limits that the user can adapt to his requirement.

  ![Set Graph Size...](image)

  - **Graph Synchronism**
    When an instrument information are displayed into 2 or more graphs, all the horizontal time axes are synchronised together.
    By zooming only one of the graphs the result is that the other are no more synchronised with the new time base.
    To keep all the graph synchronised you can use the “Sync” function from tools menu.
    Select it for each graph that has to be included into the synchronism function, then zoom into one of them.
    You can notice that all time axes are now synchronized.

• **Graph info**
  The graph information area is immediately displayed with the graph itself.
  If necessary move or drag it where it does not cover part of the interested area.
  To close the information window click on its crossed button.
  To make it appear again select “Legend” from the “Tools” menu.

• **Save a graph format**
  This function provides to save the data of the displayed graph into the hard disk of the client computer connected to XWEB.
  To start the operation select “Save” from the “Tools” menu.
  After that you can proceed by using the typical saving method of Windows operative system, remember to assign a proper name and origin of the data.
  On the bottom left side of the window you can decide which data format to save: text (TXT) or html.

• **Load a graph**
  Chose this option to load a graph previously saved.

• **Print a graph**
  To print a graph on the printer of the client PC or on another net printer, select “Print” from the “Tools” menu, the follow the typical Windows structure.

### 3.7.2 EXPORTING DATA – SINGLE DEVICE

It is possible to export data in TXT format or in HTML one. The user has to choose “Save on disk” in the “Action” menu. The standard window for graph is displayed. This time once all the wanted values are
3.7.3 EXPORTING DATA – MULTIPLE DEVICES

**WARNING**: This function is not available via modem connection.
To export multiple data go to “Data" menu, then “Main Export”. Select the typology you want to export, the following window will appear:

![Export Window](image)
The clone function lets you apply the same selected values to all the compatible controllers. The exported file is a Microsoft Excel with the following limitations:

- Maximum number of lines is 65536

The procedure will download a Java software to the client PC, if the connection is made via modem, it may take up to some minutes to. Finally, the following window will appear:

The filename format is the following:

```
export_system-description_start-date_end-date.xls
```

By pressing “save” the Java software starts the file transfer. This procedure may take a long time to
complete, it depends on the total amount of data to be transferred.

3.7.4 EXPORT TO USB PEN DRIVE

From the same page, it’s possible to select the “Export to USB”. The following screen appears:

To activate the function, the following steps are needed:

- Select the storing interval using (dd:hh) format. In this way, the export will be performed using a back analysis period of dd:hh time;
- Select the sampling interval for each values of each device that will be selected (of course, it’s possible to use the “All device” button to have a fast selection);
- Select all the devices that you’d like to export;
- Check if the USB pen drive is correctly inserted on your XWEB usb port;
- Press save button in order to activate the function;

This function always export all the data for each device. The output file is a .txt file with a format that can be quickly imported to excel. In case of error, the XWEB writes a simple error file on the output directory.

The XWEB is able to export the data from its flash memory to USB pen drive without using the configuration done with previous menu. In fact, by writing a simple text file on the USB pen it’s possible to ask to XWEB the data you want. The procedure that has to be followed to obtain the data is the following:

- Write on the root directory of your USB key the export.txt file with the following format/syntax:

```
INTERVAL
INTERVAL: can have two formats. #[h/d] where # is a number and [h/d] is the measurement unit, the other format is dd/mm/yyyy -- dd/mm/yyyy standing for from – to interval of export. After the interval of export, you can specify the sampling time in seconds. If the last field is left blank the default sampling time is 60 seconds;

LIST OF DEVICES
Is a simple list of serial address of the devices separated by comma. If instead of a list of addresses
a * is used, the export is performed for all active devices.

**EXAMPLE 1:**
3d 3600

It exports the data of all the devices for last 3 days with a sampling time of one hour

**EXAMPLE 2:**
1d 120
1,3,5

It exports the data of device with address 1,3 and 5 with for last day with a sampling time of two minutes

- Place the USB pen drive on XWEB USB port and wait till the end of process is ended. If the USB Pen is provided with a LED, it'll blink during the data transfer so wait till the LED is always ON to be sure that the transfer is correctly ended.
- Extract the USB pen from the XWEB and place it on your PC to see the data.
  1. for each exported device all the enabled values are exported
  2. there is a file for every device. The filename is related to the name of the device;
  3. the files are placed on a directory named export_AAAAMMGG-HHMMSS and builded following actual date and hour;
  4. the data inside of the file are separated by "|" char in order to be quickly importable on Excel or Open office calc;
  5. First line of each file contains the name of the values separated by the "|" char;

An example of file is the following:

```
Date/Time|Status|Room (Pb1)|Evaporator (Pb2)|Set Point|On / Off|Defrost|Keyboard|Energy Saving|Low Value Pb1|High Value Pb1|Error Pb1|Error Pb2|Open Door|External Alarm|EEPROM Failure|Defrost|Light|Fan|Cooling|Door Switch|Generic Alarm|
21/01/2010 13:32:41|4|       0.0|         0|       2.0|0|0|0|0|0|0|1|0|0|0|0|0|0|0|0|0|0|0|0|0|0|0|
21/01/2010 13:47:48|4|       0.0|         0|       2.0|0|0|0|0|0|0|1|0|0|0|0|0|0|0|0|0|0|0|0|0|0|0|
21/01/2010 14:02:57|4|       0.0|         0|       2.0|0|0|0|0|0|0|1|0|0|0|0|0|0|0|0|0|0|0|0|0|0|0|
21/01/2010 14:18:03|4|       0.0|         0|       2.0|0|0|0|0|0|0|1|0|0|0|0|0|0|0|0|0|0|0|0|0|0|0|
21/01/2010 14:33:13|4|       0.0|         0|       2.0|0|0|0|0|0|0|1|0|0|0|0|0|0|0|0|0|0|0|0|0|0|0|
21/01/2010 14:48:21|4|       0.0|         0|       2.0|0|0|0|0|0|0|1|0|0|0|0|0|0|0|0|0|0|0|0|0|0|0|
21/01/2010 15:03:29|4|       0.0|         0|       2.0|0|0|0|0|0|0|1|0|0|0|0|0|0|0|0|0|0|0|0|0|0|0|
21/01/2010 15:18:37|4|       0.0|         0|       2.0|0|0|0|0|0|0|1|0|0|0|0|0|0|0|0|0|0|0|0|0|0|0|
21/01/2010 15:33:45|4|       0.0|         0|       2.0|0|0|0|0|0|0|1|0|0|0|0|0|0|0|0|0|0|0|0|0|0|0|
21/01/2010 15:48:54|4|       0.0|         0|       2.0|0|0|0|0|0|0|1|0|0|0|0|0|0|0|0|0|0|0|0|0|0|0|
21/01/2010 16:04:02|4|       0.0|         0|       2.0|0|0|0|0|0|0|1|0|0|0|0|0|0|0|0|0|0|0|0|0|0|0|
21/01/2010 16:19:09|4|       0.0|         0|       2.0|0|0|0|0|0|0|1|0|0|0|0|0|0|0|0|0|0|0|0|0|0|0|
21/01/2010 16:34:16|4|       0.0|         0|       2.0|0|0|0|0|0|0|1|0|0|0|0|0|0|0|0|0|0|0|0|0|0|0|
21/01/2010 16:49:26|4|       0.0|         0|       2.0|0|0|0|0|0|0|1|0|0|0|0|0|0|0|0|0|0|0|0|0|0|0|
21/01/2010 17:04:35|4|       0.0|         0|       2.0|0|0|0|0|0|0|1|0|0|0|0|0|0|0|0|0|0|0|0|0|0|0|
21/01/2010 17:19:44|4|       0.0|         0|       2.0|0|0|0|0|0|0|1|0|0|0|0|0|0|0|0|0|0|0|0|0|0|0|
21/01/2010 17:34:51|4|       0.0|         0|       2.0|0|0|0|0|0|0|1|0|0|0|0|0|0|0|0|0|0|0|0|0|0|0|
21/01/2010 17:50:01|4|       0.0|         0|       2.0|0|0|0|0|0|0|1|0|0|0|0|0|0|0|0|0|0|0|0|0|0|0|
21/01/2010 18:05:09|4|       0.0|         0|       2.0|0|0|0|0|0|0|1|0|0|0|0|0|0|0|0|0|0|0|0|0|0|0|
21/01/2010 18:20:19|4|       0.0|         0|       2.0|0|0|0|0|0|0|1|0|0|0|0|0|0|0|0|0|0|0|0|0|0|0|
21/01/2010 18:35:28|4|       0.0|         0|       2.0|0|0|0|0|0|0|1|0|0|0|0|0|0|0|0|0|0|0|0|0|0|0|
21/01/2010 18:50:36|4|       0.0|         0|       2.0|0|0|0|0|0|0|1|0|0|0|0|0|0|0|0|0|0|0|0|0|0|0|
21/01/2010 19:05:45|4|       0.0|         0|       2.0|0|0|0|0|0|0|1|0|0|0|0|0|0|0|0|0|0|0|0|0|0|0|
21/01/2010 19:20:52|4|       0.0|         0|       2.0|0|0|0|0|0|0|1|0|0|0|0|0|0|0|0|0|0|0|0|0|0|0|
21/01/2010 19:36:00|4|       0.0|         0|       2.0|0|0|0|0|0|0|1|0|0|0|0|0|0|0|0|0|0|0|0|0|0|0|
```

- After having performed an export, in order to perform another operation it's necessary to remove and re-insert the USB pen.

### 3.7.5 DELETE DATA
To remove unwanted data, go to “data” -> “Graphs”. Here from the drop-down menu “Actions” choose “cancel device data”. Beware, this will remove all data recorded from the controllers.

### 3.7.6 DISPLAY THE GRAPHS WITH LOCAL PC
You can also display the graphs without connecting to a remote XWEB. First you need to save locally a graph(s) (see chapter §3.7.1 Display the graphs “Save a graph format” section). If this is the first time you
want to display a graph locally, you have to install a special software. Insert the XWEB cd-rom and go to “Utilities” section. Here install “Graph viewer”. First confirm the setup path and push “Start”.

At the end of the procedure this window will appear:

From now on you can find the program “Dixell’s graphs viewer” inside your PC start menu:

The first time you run it, depending on your PC security setup, you are required to let the software start. You can do this by clicking with right mouse button in the window header and choose “Allow Blocked Content...”.
Answer “Yes” to the following window:

Security Warning

Allowing active content such as script and ActiveX controls can be useful, but active content might also harm your computer.

Are you sure you want to let this file run active content?

Yes  No

Finally this window will open:
Pushing “Open a graph” button, first you are required to confirm java virtual machine start, then you can browse your PC for a graph file.

Use the following window to load a previously saved graph.
3.8 ALARM MENU

3.8.1 HYSTORICAL ALARMS

This function shows you all the alarm events detected from the XWEB system. It is also possible to setup a search filter.

- **Alarm view and filters**

  To enter the alarm view, click on “Alarm” -> “Historical” menu. The Device Alarm Page is divided onto 3 main section: Actions, Device filter and Alarm filter.

  The “Alarm Filter” defines which alarm level and which kind of alarm to search. The “Device Filter” defines the typology and the name of the instrument to search. The “Action” menu allows the user to decide what action to start: Save on disk in html format, view in the current window or print alarm.

  The system automatically loads all the alarm. The user can filter which one wants to view using “Actual” or “Last” and insert the number of days back to show. The alarm description is displayed in table format.

<table>
<thead>
<tr>
<th>Alm</th>
<th>Dev. Name</th>
<th>Alarm Typology</th>
<th>Alarm Name</th>
<th>Start</th>
<th>Stop</th>
<th>Ending</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>neo_XT100</td>
<td>no link</td>
<td>High Value Ph</td>
<td>05/12/2004 17:59:24</td>
<td>05/12/2004 18:50:05</td>
<td>Auto</td>
</tr>
<tr>
<td></td>
<td>neo_XT100</td>
<td>no link</td>
<td>High Value Ph</td>
<td>05/12/2004 16:53:25</td>
<td>05/12/2004 16:59:03</td>
<td>Auto</td>
</tr>
<tr>
<td></td>
<td>neo_XT100</td>
<td>no link</td>
<td>High Value Ph</td>
<td>05/12/2004 14:59:23</td>
<td>05/12/2004 15:59:26</td>
<td>Active</td>
</tr>
<tr>
<td></td>
<td>piippo</td>
<td>Systems Alarm</td>
<td>No link alarm</td>
<td>07/12/2004 16:55:00</td>
<td>07/12/2004 16:55:04</td>
<td>Stop Acq</td>
</tr>
</tbody>
</table>

Beware to the status of an alarm:

- **Active (To column):** Alarm is still active
- **Auto (ending column):** Alarm stopped automatically. It means that alarm event is now ended.
- **Stop Acq. (ending column):** Someone has stopped the recording activity
- **Restart (ending column):** System has been rebooted by someone/something.

- **Actual view of a device included into the alarm list**

  The user could be interested in having more and deep information about the actual situation of an instrument with an active alarm that is included into the alarm list. That’s why if you click on the description of the instrument itself the XWEB will load a snapshot page showing all the controller information.

- **Print the alarm list**

  Select the “Print” from the “Action” menu situated on the left corner of the alarm page under the Dixell logo. Use the structure of the operative system of your client PC to select and configure the printer then proceed with the printing.
3.9 PERMISSIONS

From the “Configuration” menu you can access “Users”. This section is one of the most important to preserve the correct functioning of the unit. You can setup others users account and grant them the permission to interact with the XWEB. Permissions are a powerful tool to avoid accidental system damage and security holes.

<table>
<thead>
<tr>
<th>Type</th>
<th>User</th>
<th>Password</th>
<th>Enabled</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>Admin</td>
<td>******</td>
<td>✔️</td>
<td>Modify</td>
</tr>
</tbody>
</table>

We strongly suggest you to create a user with read only privileges and another one with the ability to change system behaviour. The third user must be the administrator who should be the only one to be able to interact with critical system behaviour, such as alarm setup menu or devices add/delete etc.

To modify an existing user you just have to put the correct name and password (by clicking inside the box), then push on “Modify” button. Default configuration consists of one Administrator.

To allow a user to interact with the unit, please assign him correct rights. To do this check/uncheck the proper permission. At the end of the procedure you have to confirm the changes by clicking on “apply”
3.9.1 MANAGING THE USERS
You can interact with a user in 3 different ways:
- Setting-up permission.
- Disabling the user (Enabling check box on the top right corner).
- Modify account and password

3.10 TOOLS SECTION
XWEB has a complete set of useful tools to help the user managing in the best way both the monitoring unit and the controllers connected on the RS 485. Click on “Tools” menu to start using it.

3.10.1 DATA LOG STATUS
One of the most important tools is the “Data log Status”. This window gives you important information concerning the available amount of memory reserved to store data values. Value “Log” followed by a percentage is the amount of used memory at the present moment. XWEB will give you a forecast expressed in days/hours on the duration of the stored data starting back from the last recorded value. The archive is in FIFO format, so the first data (the oldest one) is also the first to be overwritten. To enlarge this recording time you can decide which values you really need to store. To do this please click on “Configuration” -> “Devices” roll-down menu and select a controller. At this point uncheck all the value you do not want to record. In the following example DI “Defrost Start” is shown but not recorded.

<table>
<thead>
<tr>
<th>Digital Input</th>
<th>Name</th>
<th>Sh.</th>
<th>Rec.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Defrost Start</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Generic DI</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

3.10.2 RS 485 TEST
It is possible to make a test on the RS 485 line. Click on “RS 485”. The following window will appear:

<table>
<thead>
<tr>
<th>Modbus Comunication Statistic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Addr</td>
</tr>
<tr>
<td>------</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>7</td>
</tr>
</tbody>
</table>

Update  Reset
By clicking on “Test” XWEB starts sending data packet to the selected controller. Depending on the number of sent back packet the percentage is shown in 3 different colours: red (bad connection), yellow (average connection) and green (good connection). This tool is useful to discover problem on the RS 485 wiring.

3.10.3 SERVER STATUS

Click on “Tools” -> “Server Status”. This window gives you important information about the XWEB status. If there is some errors, they will be displayed in this section. The user can access this window also from the home page. The label “Server Status” show you the current status. If there is an error a small icon will appear. By clicking on it a report windows will appear.

3.10.4 MESSAGE STATUS

Click on “Tools” -> “Message status”. This windows show you the status queue of all messages that have to be sent by XWEB. If the server did not succeed in sending a message, an error is shown.
3.11 INFORMATION MENU

3.11.1 SYSTEM VERSION
In the submenu “About” there is the system release:

In the above image, the system release is 1.0.

3.11.2 SYSTEM UPDATE

One of the most important feature of XWEB is the possibility to update the system via modem connection or local Ethernet cable. Update procedure can be managed only by the administrator. This user has to click on “Information” -> “Update” menu. Standard browsing windows will appear. Chose the proper file and push “open”. This procedure may take as long as 5-10 minutes. During this period the system stops its monitoring functions. Dixell S.r.l. will provide you new software release when available.
4 SAFETY AND ALLOWED USE

Please read carefully what follows. Your security may depend on the respect of these simple rules. We strongly suggest you, to prevent damage to the unit, paying attention to each sentence.

- Remember to protect both yourself and the computer from electrical hazards. The XWEB should remain turned off until you are finished connecting all electrical devices.
- Before giving the power supply, read the Technical Specification to be sure of the supply voltage you are going to connect.
- The appliance should be connected to a power supply only of the type described in the instruction manual or as marked on the appliance. If you are not sure of the type of power supply to your installation site, consult your appliance dealer or local power company.
- Power-supply cords should be routed so that they are not likely to be walked on or pinched by items placed upon or against them, pay particular attention to cords at plugs, convenience receptacles, and the point where they exit from the appliance.
- The appliance may not function properly if used at extremely low, or freezing temperatures. The ideal ambient temperature is above +5°C (41°F).
- The appliance should be situated away from heat sources such as radiators, heat registers etc.
- Care should be taken so that objects do not fall and liquid is not spilled into the enclosure through openings.
- Never remove the enclosure. If the internal parts are touched accidentally, a serious electric shock might occur.
- Do not use volatile solvents such as alcohol, paint thinner, gasoline, or benzine, etc. to clean the cabinet. Use a clean dry cloth.
- The user should not attempt to service the appliance beyond that described in the instruction manual. All other servicing should be referred to qualified service personnel.
## 4.1 SYSTEM SPECIFICATION

### (DIN MODELS ONLY)

<table>
<thead>
<tr>
<th><strong>General</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimensions (custom case)</td>
<td>175 (w) x 110 (h) x 60 (d) (mm)</td>
</tr>
<tr>
<td>Power Supply</td>
<td>110÷230 VAC 50~60Hz.</td>
</tr>
<tr>
<td>Power Consumption</td>
<td>15 W</td>
</tr>
</tbody>
</table>

### Environmental Safe

| Temperature range | Above +0°C – 60°C (32°F – 104°F) |
| Humidity | between 20% and 85% |

### (COOLMATE MODELS ONLY)

<table>
<thead>
<tr>
<th><strong>General</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimensions (custom case)</td>
<td>230 (w) x 210 (h) x 87 (d) (mm)</td>
</tr>
<tr>
<td>Power Supply</td>
<td>230 VAC 50<del>60Hz or 110VAC 50</del>60Hz depending on the model</td>
</tr>
<tr>
<td>Power Consumption</td>
<td>20 W</td>
</tr>
</tbody>
</table>

### Environmental Safe

| Temperature range | Above +0°C – 60°C (32°F – 104°F) |
| Humidity | between 20% and 85% |
Appendix A: DEVICE ADVANCED SECTION
Appendix B: GLOSSARY
Appendix C: ACCESSORIES
Appendix D: GPRS CONNECTIVITY (only for DIN)
Appendix A: DEVICE ADVANCED SECTION

In this section we describe how you can customize your device regardless its factory setup. We will point out only the main sections, without describing each fields in deep. Please notice that the page is divided in many rows. Each of them customizes a particular function of the device itself.

To access this section please stop data reading/recording, then go to “Configuration”->”Devices” roll-down menu. Here with selection “Actions” roll-down menu choose “Advanced”, then with “Devices” choose the proper controller.

“Analog Input” section shows you all the analog input that a device can use. These values can be displayed in decimal or integer values, of course you have to choose the same unit of measurement for both the XWEB and the instrument. The suffix “-I” means you want to display integer, default value is decimal. The same for Celsius and Fahrenheit degree. The suffix “-F” means Fahrenheit degree.

Warning: the integer/decimal or °C/°F configuration have to be chosen according to the real setting of the instruments.

<table>
<thead>
<tr>
<th>Analog Input</th>
<th>Set Point</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Vis.</td>
</tr>
<tr>
<td>Probe</td>
<td>✓</td>
</tr>
<tr>
<td>Probe (Int - °F)</td>
<td>□</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

“Digital Input” row need particular attention. The values you find here are the factory defaults, so if you have made modifications to the device setup, you are requested to apply the same modifications in this menu. This is very important because all the values stored inside XWEB devices section must be the same as the ones stored inside the EEPROM of the instrument. A common error for example is to modify “Generic Alarm” to some other values inside the instrument, than leave the value marked inside Advanced section. XWEB will send you an alarm every time the switch changes status, even if it is not a generic alarm.

<table>
<thead>
<tr>
<th>Digital Input</th>
<th>Vis.</th>
<th>Order</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Defrost Start</td>
<td>✓</td>
<td>0</td>
</tr>
<tr>
<td>Generic DI</td>
<td>✓</td>
<td>0</td>
</tr>
<tr>
<td>Generic Alarm</td>
<td>□</td>
<td>0</td>
</tr>
<tr>
<td>Generic DI</td>
<td>□</td>
<td>0</td>
</tr>
<tr>
<td>Defrost Start</td>
<td>□</td>
<td>0</td>
</tr>
<tr>
<td>Generic Alarm</td>
<td>□</td>
<td>0</td>
</tr>
</tbody>
</table>

“Device Status” section allows you to customize your instruments, of course the same values have to be set both on XWEB and the instruments themselves.

<table>
<thead>
<tr>
<th>Device Status</th>
<th>Vis.</th>
<th>Order</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td></td>
<td></td>
</tr>
<tr>
<td>On / Off</td>
<td>✓</td>
<td>0</td>
</tr>
<tr>
<td>Digital Input</td>
<td>✓</td>
<td>0</td>
</tr>
<tr>
<td>Defrost</td>
<td>✓</td>
<td>0</td>
</tr>
</tbody>
</table>

“Commands” row is very important. You have to mark same values that you have marked before in the other section. In order to give XWEB the possibility to send commands to the instruments. This is necessary because for example if you have changed “Generic Alarm” to “Auxiliary” in “digital Resources” section, then you have to mark “Aux on” and “Aux off” in “Commands” section to be able to turn on/off the output by...
means of the XWEB. Of course you have to do this kind of changes every time you have made some modifications to the controllers.
Appendix B: GLOSSARY

C
Cable - Transmission medium of copper wire or optical fiber wrapped in a protective cover.
Client/Server - A networking system in which one or more file servers (Server) provide services; such as network management, application and centralized data storage for workstations (Clients).
CSMA/CD - Carrier Sense Multiple Access Collision Detection is a network access method in which devices that are ready to transmit data first check the channel for a carrier. If no carrier is sensed, a device can transmit. If two devices transmit at once, a collision occurs and each computer backs off and waits a random amount of time before attempting to retransmit. This is the access method used by Ethernet.
Coaxial Cable - Cable consisting of a single copper conductor in the center surrounded by a plastic layer for insulation and a braided metal outer shield.
Concentrator - A device that provides a central connection point for cables from workstations, servers, and peripherals. Most concentrators contain the ability to amplify the electrical signal they receive.

E
E-mail - An electronic mail message sent from a host computer to a remote computer.
End User - Refers to the human executing applications on the workstation.

F
File Server - A computer connected to the network that contains primary files/applications and shares them as requested with the other computers on the network. If the file server is dedicated for that purpose only, it is connected to a client/server network. An example of a client/server network is Novell Netware. All the computers connected to a peer-to-peer network are capable of being the file server. Two examples of peer-to-peer networks are LANtastic and Windows for Workgroups.

I
ISP (Internet Service Provider) - Company that provide access to internet

M
Modem (Modulator/Demodulator) - Devices that convert digital and analog signals. Modems allow computer data (digital) to be transmitted over voice-grade telephone lines (analog).

P
PCMCIA - An expansion slot found in many laptop computers.
Point-to-Point - A direct link between two objects in a network.
Ports - A connection point for a cable.
Protocol - A formal description of a set of rules and conventions that govern how devices on a network exchange information.

R
RAM (Random Access Memory) - The working memory of a computer where data and programs are temporarily stored. RAM only holds information when the computer is on.
**Speed of Data Transfer** - The rate at which information travels through a network, usually measured in megabits per second.

**Workstation** - A computer connected to a network at which users interact with software stored on the network.
Appendix C: ACCESSORIES

<table>
<thead>
<tr>
<th>TYPE</th>
<th>DESCRIPTION</th>
<th>COMMERCIAL NAME</th>
<th>HOW-TO ORDER</th>
</tr>
</thead>
<tbody>
<tr>
<td>MODEM</td>
<td>Analog SERIAL modem, PDA compatible, 56kbps</td>
<td>XWEB MODEM</td>
<td>XWEBMODEM-200 (24Vac)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>XWEBMODEM-400 (110Vac)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>XWEBMODEM-500 (230Vac)</td>
</tr>
<tr>
<td>MODEM GSM</td>
<td>GSM modem KIT</td>
<td>TC35-KIT</td>
<td>TC35-KIT</td>
</tr>
<tr>
<td>CABLE</td>
<td>Ethernet patch cable compatible with XWEB500, 3m</td>
<td>###</td>
<td>CAB/WEB/NET</td>
</tr>
<tr>
<td>CABLE</td>
<td>Ethernet patch cross-over cable compatible with XWEB500, 1m</td>
<td>###</td>
<td>CAB/WEB/PC</td>
</tr>
</tbody>
</table>

Appendix D: GPRS CONNECTIVITY (ONLY FOR DIN)

GPRS connectivity and all the associated services are a prerogative of the mobile operator. When selecting the operator and the price plan bear the following in mind:

- the IP address assigned by the mobile network to the XWEB must be public, only in this way XWEB will be visible from the Internet and the DDNS service
- Select a flat plan, that counts volume and not time: the exchanged data for the parameter and graphs consultation are of a few MB and the connection is preferable to be always on, so to keep the XWEB always available.
- Check both the selected operator coverage and signal quality for the XWEB installation area.

Plan the XWEB use: even if the GPRS connection is more efficient than the GSM modem one (9.6 kb / s), speed maximum limit is 40 kb/s (upload from XWEB to a web browser)

<table>
<thead>
<tr>
<th></th>
<th>Download (kbit/s)</th>
<th>Upload (kbit/s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>3R2T</td>
<td>60</td>
<td>40</td>
</tr>
</tbody>
</table>

Therefore, limit as much as possible the use of the layout that involves sending images, simultaneous access of multiple users to XWEB at the same, downloading large amounts of data.

The mobile network assigns dynamic IP addresses to XWEB (unless you choose price plan with a static IP) that change over time. XWEB manages DDNS, a service that some operators offer for free, that allows you to update and keep the IP assigned by the mobile network aligned with a specific name (hostname). Create for each XWEB, an account at one of these DNS Dynamic operators (DynDns, ChangeIP, NoIP) and assign to XWEB a hostname (e.g. Myxweb01.homeip.net). In this way the XWEB myxweb.homeip.net will always be accessible even if your IP changes.
Example

1) Connect the antenna and insert the SIM of your operator.

2) From XWEB main menu select “Configuration→System”. A window will appear where to select “Modem Setup”. A window as shown in the following picture will appear. Set the modem as internal (“internalGSM”). Enable calls from “internal modem”. The selection of external modem must not be set.
3) Press “Dialup Setup”. In the “Dial-up” section select ‘No dial-up’. Configure the “GPRS configuration” according to your own operator’s data and to the internet connection that you have. It is advisable to stipulate a ‘flat’ price plan with your operator, so to have a connection that is available when you connect in remote. Ask your operator for a public IP.

To access XWEB with a public but dynamic IP, DNS services as “changeip”, “dyndns” or “noip”, can be used.
4) For the DNS with dynamic IP configuration, connect to the website

![DynDNS.com screenshot](https://www.dyndns.com/account/services/hosts)

4) For the DNS with dynamic IP configuration, connect to the website

5) And fill in the red border fields. Press “Add To Cart”.

Follow the guided procedure to the end with the checkout DNS name chosen for its activation. Transfer the name and the other parameters from the xweb GPRS configuration window indicated previously at point 2.